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C H A P T E R 1
Overview

This section contains the following topics:

• Audience, on page 1
• Overview of Cisco Crosswork Change Automation and Health Insights, on page 1
• Integration with other Cisco and non-Cisco products, on page 2
• Licensing, on page 2

Audience
This guide is for experienced network administrators who want to use Cisco Crosswork Change Automation
and Health Insights in their network. This guide assumes that you are familiar with the following topics:

• Networking technologies and protocols (IS-IS, BGP, and so on)

• Network monitoring and troubleshooting

• Familiarity with the Cisco Crosswork Infrastructure 4.0 and how the applications are installed. For more
information, see Cisco Crosswork Infrastructure 4.0 and Applications Installation Guide.

Overview of Cisco Crosswork Change Automation and Health
Insights

Cisco Crosswork Change Automation and Health Insights is part of the Cisco Crosswork Network Automation
suite of products. Cisco Crosswork Change Automation and Health Insights retrieves real-time information
from the network, analyzes the data, and uses APIs to apply network changes. The Cisco Crosswork Change
Automation and Health Insights platform brings together streaming telemetry and model-driven application
programming interfaces (APIs) to redefine service provider network operations.

Cisco Crosswork Change Automation and Health Insights enables service providers to quickly deploy
intent-driven, closed-loop operations. The platform provides a ready-to-use solution supporting the following
use cases:

• Monitor Key Performance Indicators (KPIs) and notify of any anomalies.

• Prepare network changes triggered by changes in KPIs and roll out these changes.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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• Automate change-impact and remediation.

This guide explains how to use Cisco Crosswork Change Automation and Health Insights.

For more information about the Cisco Crosswork Network Automation platform, see the Cisco Crosswork
Network Automation Product page on Cisco.com.

Integration with other Cisco and non-Cisco products
Crosswork API: Cisco Crosswork Change Automation and Health Insights provides a robust set of APIs that
allow it to be integrated with other tools you use to manage and configure your network. For more details on
the product APIs, see the Cisco Crosswork Network Automation API Documentation on Cisco DevNet.

Cisco WAE: Cisco WAN Automation Engine (Cisco WAE) providers supply traffic and topology analysis
to Cisco Crosswork Change Automation and Health Insights. The foundation software is CiscoWAE Planning,
which provides a cross-sectional view of traffic, topology, and equipment state.

Cisco NSO: Cisco Crosswork Change Automation and Health Insights uses Cisco Network Services
Orchestrator (Cisco NSO) as the default provider to configure the devices according to their expected functions,
including configuring any required model-driven telemetry (MDT) sensor paths for data collection. Cisco
NSO is vital in supplying device management and configuration-maintenance services.

Crosswork Active Topology: Cisco Crosswork Active Topology enables visualization of topology and
services on logical and geographical maps.

Crosswork Optimization Engine: Cisco Crosswork Change Automation and Health Insights uses instances
of Cisco Crosswork Optimization Engine to provide real-time network optimization allowing operators to
effectively maximize network utilization as well as increase service velocity.

Crosswork Zero Touch Provisioning: Cisco Crosswork Change Automation and Health Insights works with
Crosswork Zero Touch Provisioning (ZTP) to allow users to bring up devices quickly and easily using a
Cisco-certified software image and a day-zero software configuration of the customer's choice. Once provisioned
in this way, the new device is onboarded to the Crosswork device inventory (and, if it is configured as a
Crosswork Provider, to Cisco NSO), where it can be monitored and managed like other devices.

Syslog Server: Cisco Crosswork Change Automation and Health Insights interacts with syslog server to parse
the syslog events from devices in recognized formats (RFC5424 and RFC3164).

Licensing
Change Automation and Health Insights are separately licensed applications. The Change Automation license
count increments for each new playbook. Health Insights license is based on the number of KPIs you have
enabled (via a KPI Profile), and the license count increments for each enabled KPI.

To purchase a Cisco Crosswork Change Automation and Health Insights license, contact your Cisco account
representative.

For more about licensing, see the Cisco Crosswork Network Automation Product Data Sheet on Cisco.com.

For demonstrations and field trials, Cisco Crosswork Change Automation and Health Insights can be used
without a license for up to 90 days.

Note
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C H A P T E R 2
Get Started

This section contains the key workflows of Cisco Crosswork Change Automation and Health Insights:

• Getting Started, on page 3
• Workflow 1: Configure Network View, on page 4
• Workflow 2: Monitor Key Performance Indicators, on page 4
• Workflow 3: Respond to KPI Data, on page 4
• Workflow 4: Schedule Playbooks, on page 5
• Workflow 5: Develop Custom KPIs, on page 6
• Workflow 6: Develop Custom Playbooks, on page 7

Getting Started
For details, see...Step

Refer the Cisco Crosswork
Infrastructure 4.0 and Applications
Administration Guide

1. Populate the Cisco Crosswork Change Automation and Health
Insights environment and set up Cisco Crosswork Data Gateway.

ConfigureChangeAutomation Settings,
on page 24

2. Configure the Change Automation settings.

Workflow 1: Configure Network View,
on page 4

3. (Optional) Setup and configure your map settings.

Workflow 2:Monitor Key Performance
Indicators, on page 4

4. Create KPI Profiles to monitor device Key Performance Indicators
(KPIs) for issues and anomalies.

Workflow 3: Respond to KPI Data, on
page 4

5. Link KPIs to playbooks.

Workflow 4: Schedule Playbooks, on
page 5

6. Schedule Playbooks to perform routine maintenance.

Workflow 5: Develop Custom KPIs,
on page 6

7. Expand telemetry insight with custom KPIs.

Workflow 6: Develop Custom
Playbooks, on page 7

8. Remediate common scenarios and automate routine tasks with
custom playbooks.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Workflow 1: Configure Network View
The following workflow describes the steps to configure the map display settings in Cisco Crosswork Change
Automation and Health Insights:

ActionStep

Follow the instructions in Create and
Modify Device Groups, on page 19 and
Enable Dynamic Device Grouping, on
page 20.

1. Group your devices logically as per your requirement.

Follow the instructions in Customize
Map Display Settings, on page 20.

2. Set display preferences for your topology.

Follow the instructions in Save
Topology Views for Easy Access, on
page 21.

3. Manage your custom topology views.

Workflow 2: Monitor Key Performance Indicators
Once you have completed initial setup, use Cisco Crosswork Change Automation and Health Insights to begin
device performance monitoring using KPI Profiles.

ActionStep

Refer the Cisco Crosswork Change
Automation and Health Insights 4.0
Administration Guide for the procedure.

1. (Optional) Tag all of the devices whose KPIs you plan to monitor
with a tag indicating the function they perform, per your plan.

Review the Cisco-supplied KPIs
documented in List of Health Insights
KPIs, on page 64.

To create a new KPI that fits your
requirement, see Create a NewKPI, on
page 60.

2. Plan which Cisco-supplied KPIs you want to begin using, based
on each device's function and the device performance characteristics
you want to monitor.

Follow the instructions in Create a New
KPI Profile, on page 70.

3. Based on your experience or by using the recommendation engine,
group the KPIs to form KPI Profiles.

Review and follow the instructions in
Monitor Network Health and KPIs, on
page 53

4. Enable the appropriate KPI Profiles on the devices you want to
monitor.

Workflow 3: Respond to KPI Data
The following workflow describes the steps to follow when using Cisco Crosswork Change Automation and
Health Insights Playbook to reconfigure the network in response to KPI alerts detected by Health Insights:

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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ActionStep

Follow the instructions in Monitor
Network Health and KPIs, on page 53,
using the View Alerts for Network
Devices, on page 56 to research the
alerts and their possible causes.

1. Research the KPIs that are triggering alerts, and determine the
best corrective action to take for the situation your network has
experienced.

Review the list of Plays, Playbooks,
and generic parameters in the
"Playbooks" and "Verbs" references in
the Change Automation Developer
Guide on Cisco Devnet.

2. Review the Cisco-supplied Playbooks and determine which ones
will allow you to address the situation.

See:

Perform a Dry Run of a Playbook, on
page 41

Run Playbooks In Single Stepping
Mode, on page 43

Run Playbooks In Continuous Mode,
on page 46

3. Try out the selected Playbooks and see if they are applicable to
your purposes. As you experiment, adjust the Playbook parameters
as needed.

Follow the steps in Link KPIs to
Playbooks, on page 62. Use the
Remediation icon shown inViewAlerts
for Network Devices, on page 56 to
trigger a run of a linked Playbook from
a device or KPI alert.

4. If the Playbooks are appropriate for your purposes, and the
situation occurs often, link the selected Playbooks and KPIs, so
alerts triggered by a KPI will always display the linked Playbook
for selection by operators.

Once the KPI and Playbook are linked, operators can click on the
Remediation icon, modify the Playbook parameters as needed, and
execute the selected Playbook.

Workflow 4: Schedule Playbooks
The workflow below describes the steps to follow when using Cisco Crosswork Change Automation and
Health Insights to automate routine network upkeep, and to verify that each routine change completed correctly.

This workflow is applicable only if scheduling is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings, on page 24.

Note

ActionStep

SeeAbout Running Playbooks, on page
40 and View the Playbook List, on
page 27

1. Identify routine maintenance tasks (such as throughput checks,
software upgrades, SMU installs, and so on) that you perform on a
regular schedule and that may be suitable for automation using one
or more Cisco Crosswork Change Automation and Health Insights
Playbooks.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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ActionStep

SeeAbout Running Playbooks, on page
40 and Schedule Playbook Runs, on
page 49

2. Configure Playbooks to perform these tasks at the desired time.

See Use the Change Automation
Dashboard, on page 25 and View or
Abort Playbook Jobs, on page 50

3. Review the Change Automation Job History to review the current
status of the Playbook and confirm that it ran successfully.

Workflow 5: Develop Custom KPIs
The following workflow describes the steps to follow when considering whether or not to develop Cisco
Crosswork Change Automation and Health Insights custom KPIs for your special needs, and how to proceed
if you decide you do.

ActionStep

Follow the instructions in Monitor
Network Health and KPIs, on page 53,
using the View Alerts for Network
Devices, on page 56 to research the
alerts and their possible causes.

1. Review the existing KPIs to make sure the telemetry you want to
monitor is not already available.

Review the KPIs in List of Health
Insights KPIs, on page 64.

2. Review the data available from the devices you want to monitor
to see if they can supply the needed information:

• If they can, proceed with building a custom KPI.

• If they cannot: Contact Cisco to see if we can include the
required data in a future version of the device code.

The latest information on the data your devices can provide is always
available at the Cisco Telemetry Data Mapper
(https://tdm.cisco.com).

See Create a New KPI, on page 60 and
Create a New KPI Profile, on page 70

3. Build the custom KPI and add it to a KPI Profile.

See Enable KPI Profile on Devices, on
page 73 and View Alerts for Network
Devices, on page 56

4. Enable the new KPI Profile on a test device and confirm that the
data reported matches your expectations. Be aware that KPIs that
depend on data over time to establish baseline performance will
need some time to "calibrate" before they provide meaningful data.

Follow the steps in Enable KPI Profile
on Devices, on page 73.

5. If the KPI Profile is meeting expectations, enable it on all devices
where you consider it applicable.

See Verify the Deployment Status of
Enabled KPIs, on page 63

6. Review the Health Insights Job History to make sure the KPI
Profile was deployed to all targeted devices

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Workflow 6: Develop Custom Playbooks
The following workflow describes the steps to followwhen deciding to develop a Change Automation custom
Playbook.

ActionStep

Review the Plays, Playbooks, and
parameters in the "Playbooks" and
"Verbs" references in the Change
Automation Developer Guide on Cisco
Devnet.

1. Review the existing Playbook to see if any of them meet your
needs fully or partially.

See Export Playbooks, on page 382. Find the Playbook that most closely matches your requirements
and export that Playbook. Once you get good at modifying Playbook,
you may choose to build them from scratch and skip this step.

Review the "Custom Playbooks"
tutorial in the Change Automation
Developer Guide on Cisco DevNet.

3. Modify the exported Playbook or create a new Playbook as
necessary to meet your requirements.

First, follow the instructions in Import
Playbooks, on page 39. Then:

Perform a Dry Run of a Playbook, on
page 41

Run Playbooks In Single Stepping
Mode, on page 43

Run Playbooks In Continuous Mode,
on page 46

4. Import the new Playbook and then perform a dry run, or run it in
single-stepping or continuous mode against a test device or devices,
to confirm that it performs as expected.

See:

Link KPIs to Playbooks, on page 62

Schedule Playbook Runs, on page 49

5. For a Playbook you have developed that meets your needs:

• In response to KPI alerts: If the Playbook is meeting
expectations, link it to the KPI that indicates the need for the
Playbook to be run, so that it is easy for operators to trigger the
Playbook in response.

• For planned maintenance or configuration changes: Schedule
the Playbook to run, or run it, at the planned time.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
7

Get Started
Workflow 6: Develop Custom Playbooks

https://developer.cisco.com/docs/crosswork/#!addremove-rd-under-bgp-vrf-on-a-router
https://developer.cisco.com/docs/crosswork/#!all_interface_state_snmp
https://developer.cisco.com/docs/crosswork/#!custom-playbooks
https://developer.cisco.com/docs/crosswork/#!custom-playbooks
https://developer.cisco.com/docs/crosswork/#!custom-playbooks
https://developer.cisco.com/docs/crosswork/#!custom-playbooks/table-of-contents
https://developer.cisco.com/docs/crosswork/#!custom-playbooks/table-of-contents
https://developer.cisco.com/docs/crosswork/#!custom-playbooks/table-of-contents


Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
8

Get Started
Workflow 6: Develop Custom Playbooks



C H A P T E R 3
Set Up and Monitor Your Network View

Familiarize yourself with the UI and set up your network view before managing SR policies and RSVP-TE
tunnels. This section contains the following topics:

• Get a Quick View in the Dashboard, on page 9
• View Devices and Links on the Topology Map, on page 11
• Use Device Groups to Filter Your Topology View, on page 16
• Customize Map Display Settings, on page 20
• Save Topology Views for Easy Access, on page 21

Get a Quick View in the Dashboard
The Home page displays the dashboard which provides an at-a-glance operational summary of the network
being managed, including reachability and operational status of devices. Each dashlet represents different
types of data belonging to the same category.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Figure 1: Crosswork Home page

DescriptionCallout
No.

Main Menu: The main menu allows you to navigate to installed Cisco Crosswork applications
and device management and administrative tasks. Menu options may look slightly different
depending on what Cisco Crosswork applications are installed.

1

Dashlets: Information varies depending on what Cisco Crosswork applications are installed.

• To drill down for more information within a dashlet, click on a value. A window appears
displaying only the filtered data you clicked on.

• To add or change the layout of dashlets, click Customize View. Move the dashlets to your
desired layout and click Save.

2

Settings icons:

The Alerts icon notifies you of any current error conditions related to the system operations
which require attention, and provides a link to detailed information about those conditions.

The Events icon notifies you of new events related to system operation, and also provides
access to the history of all system events.

The About icon displays the current version of the Cisco Crosswork product.

The User Account icon lets you view your username, change your password, and log out.

3
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View Devices and Links on the Topology Map
To view the network topology map, from the main menu choose Topology.

Figure 2: Cisco Crosswork UI and Topology Map

DescriptionCallout
No.

Topology Map View: From the Show drop-down list, click the option that displays the data that
you would like to see on the map.

If Topology is selected, devices and links in the network are displayed.

1

Device Groups: From the drop-down list, click the group of devices that you want to focus on
the topology map. All other device groups will be hidden.

2
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DescriptionCallout
No.

Topology Map: The network topology can be displayed on a logical map or a geographical map,
where the devices and links are shown in their geographic context. From the map, you can drill
down to get detailed information about devices and links.

Devices:

• To view a device configuration summary, hover the mouse cursor over the device icon. A
pop up window displaying the host name, state, node ID, and device type appears.

• To view device details, click on the device icon.

• If devices are in close physical proximity, the geographical map shows them as a cluster.

The number in a blue circle ( ) indicates the number of devices in the cluster. Displaying
devices in this manner helps prevent overlap and clutter on the map.

Links:

• A solid line indicates a single link between two devices. If there is more than one link between
two devices, or between a device and a cluster of devices, the line is shown dashed instead.
A dashed line indicates an aggregated link that represents more than one link, or the use of
multiple protocols (for example, IPv4 and IPv6) on the same physical link.

• To view link information details, click on the link.

3

: The logical map shows devices and their links, positioned according to an automatic layout
algorithm, ignoring their geographical location. You can change the layout algorithm.

: The geographical map shows single devices, device clusters, links, and tunnels, superimposed
on a map of the world. Each device location on the map reflects the device's GPS coordinates
(longitude and latitude) as defined in the device inventory.

: The Display Preferences window allows you to change display settings for devices, links,
and utilization.

4

Expand/Collapse/Hide Side Panel: Expand or collapse the contents of the side panel. Close the
side panel to get a larger view of the topology map.

5

The content of this window changes depending on what Show is set to for the Topology Map
and if you have selected to view more information on a device or link.

6

Saved Custom Map Views: Lets you create a named custom view using the settings and layout
for your current map, settings of the tables saved in the saved views, or display a custom view
you have created previously.

7

View Device and Link Details
This example shows how you can view device and link details using the topology map.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Step 1 From the main menu choose Topology.

Step 2 To quickly view the host name, reachability state, IP address and type of device, hover the mouse over the device icon.

Step 3 To view more device details, click on the device icon.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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In a multiple IGP setup, you can also view all the IGP, IS-IS, and OSPF processes. See the following examples:

Figure 3: Multiple IGP: OSPF Processes

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Figure 4: Multiple IGP: ISIS Processes

Figure 5: Multiple IGP: OSPF and ISIS Processes

Step 4 To view links on the device, click the Links tab and expand the right panel to see all the link details.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Step 5 Collapse the side panel and close the Device Details window.
Step 6 Click on a dashed line. A dashed line indicates an aggregated link that represents more than one link, or the use of multiple

protocols (for example, IPv4 and IPv6) on the same physical link.. The links are displayed.

Use Device Groups to Filter Your Topology View
To help you identify, find, and group devices for a variety of purposes, you can create Device Groups. The
Device Group window (Device Management > Groups) displays all devices and device groups they belong
to. By default, all devices initially appear in the Unassigned Devices group.

This example walks you through how Device Grouping works in the geographical and logical maps.

Step 1 From themainmenu, chooseTopology. By default, only devices that have Geo Location set will appear on the geographical
map.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
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Step 2 From the Device Group drop-down list select a group (US West). Only the devices in that group and related links are
displayed on the geographical map. Note that the Devices table has also been filtered to list only those devices in the
group.

Step 3 Click .
Step 4 From the Device Group drop-down list, select All Locations and check Show Groups if it is not already checked. Note

that you can see all device groups in this view. Device groups can be seen in this way only within the logical map.
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If Show Groups checkbox is de-selected, all the device groups are expanded , and could lead to a a cluttered
map.

Note

Step 5 Click the US West group. Again, only devices that belong to this group are shown in the topology map and the Devices
table.
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Step 6 Filter devices in the Device table by entering S7C in the hostname. The Device table displays only devices that match
the filtering criteria. However, filtering the Device table does not filter the devices visually on the topology map. The
only way to visually filter devices on the geographical or logical maps is to use device groups.

Create and Modify Device Groups

Step 1 From the main menu choose Device Management > Groups.

Step 2 From the Device Groups tree, click next to a group.

Step 3 Choose to add, delete, or edit (rename or move) a group. If you delete a group, all devices that belong to that group are
moved to the Unassigned Devices group.

Devices can belong to only one device group.Note
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Step 4 Click Save.

Enable Dynamic Device Grouping
You can create a rule to dynamically create device groups and automatically add unassigned devices to these
groups using a Regular Expression (regex) on the device hostname. Any newly added or discovered devices
that matches the rule will be placed in the group.

Dynamic rules do not apply to devices that already belong in groups. You must move them to Unassigned
Devices if you want to include them as part of the devices that the dynamic rule will consider.

Note

Before you begin

While you can follow examples given in the Dynamic Groups dialog, it is helpful to be familiar with Regular
Expressions.

Step 1 From the main menu choose Device Management > Groups.

Step 2 Click .
Step 3 Click Show more details and examples to help you fill out the required Host Name and Group Name fields.
Step 4 If there are any existing devices in the Unassigned Devices group, click Test Rule to view a sampling of what type of

group names will be created.
Step 5 Check theEnable Rule checkbox. After the rule is enabled, the system checks devices every minute and will either create

or assign them into groups.
Step 6 Click Save.
Step 7 Groups that are created this way initially appear under Unassigned Groups (created when a rule is enabled for the first

time). Move newly created groups to the corresponding group hierarchy.
Step 8 To move newly created Unassigned groups to the correct group, do the following:

a) Select … next to All Locations and click Add a Sub-Group.
b) Enter the New Group details and click Save.
c) Select … next to the unassigned created dynamic group and select Edit Group Properties.
d) Click Change Parent Group and select the appropriate group.

Customize Map Display Settings
You can configure visual settings on the topology map based on your needs and preferences. You can do the
following:

• Customize the Display of Links and Devices, on page 21
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Customize the Display of Links and Devices
To set device and link map display preferences, click on the topology map.

• For devices, you can choose whether to show the device state and how the devices should be labeled.
By default, the device state is shown on the map and the host name is used to label devices.

• For links, you can choose whether to show aggregated links and how links should be colored so that you
can easily see their state and utilization status. By default, aggregated links will be differentiated from
single links on the map and links will be colored based on link utilization thresholds. Administrators can
change the utilization thresholds and their corresponding colors.

Save Topology Views for Easy Access
When you rearrange the devices and links on a map, your changes are not normally saved. When you open
the map later, your map settings are lost.

To easily access a useful map layout, you can save it as a named custom view and quickly retrieve it, without
having to rearrange the map each time. This is especially useful when managing large networks with many
devices.

When you save a custom view, the following settings will be saved:

• Whether it is a geographical or logical map.

• Device positions in the logical map layout.

• Device and link display settings

All custom views can be seen by all users. However, only users with the admin role or users that created the
custom view can edit (modify, rename, or delete) the view.

Note

Step 1 To create a custom view:
a) Customize the current map view until it contains only the information you want and until the layout meets your needs.
b) When you have the view the way you want it, click Save View.
c) Enter a unique name for the new custom view and click Save.

Step 2 To delete a custom view:
a) Click the Saved Views field.

b) Find the custom view you want to delete and click .

Step 3 To edit a custom view:
a) Click the Saved Views field.
b) Click the custom view you want to edit. The custom view appears.
c) Make any changes to the current view and click Save View. This overwrites the previously saved view.

Step 4 To rename or save a view with another name:
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a) Click the Saved Views drop-down list.
b) Select the appropriate option.
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C H A P T E R 4
Automate Network Changes

This section contains the following topics:

• Change Automation Overview, on page 23
• About Custom Plays, on page 28
• About Customizing Playbooks, on page 33
• About Running Playbooks, on page 40
• Troubleshoot Change Automation, on page 51

Change Automation Overview
The Change Automation application automates the process of deploying changes to the network. You can
define automation tasks to achieve the intended network states in Change Automation using Playbooks that
consists of plays written using YAML. You can then push configuration changes to Cisco Network Service
Orchestrator (NSO), which deploys these changes to the network devices.

The difference between Change Automation and other existing scripted automation frameworks is that Change
Automation is a closed-loop framework. Changes are deployed to the router or other device using programmable
APIs, and the intent of the change is verified using telemetry that comes back from the router. Change
Automation relies on telemetry to verify the intent of the change, avoiding the need to frequently poll the
device for updates.

The following is a high-level Change Automation workflow:

1. Define your desired network changes in a Change Automation Playbook.

2. Push configuration changes to the network device using Cisco Network Services Orchestrator API, a
configuration services provider.

3. Receive real-time feedback via telemetry from the devices, telling you that the network changes were
made and the impact of the changes. You can also use post-change KPIs to determine if a particular change
should be undone and the devices returned to their previous configuration. In addition to telemetry, Change
Automation also allows for data collection via SNMP and CLI XDE packs.

Change Automation comes with a robust library of Playbooks, each with its own collection of atomic
configuration and check plays. (A Playbook consists of multiple plays.)

Change Automation allows you to customize and generate plays and Playbooks using its API interface. For
more information, see About Custom Plays, on page 28 and About Customizing Playbooks, on page 33.
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Configure Change Automation Settings
This section explains the initial settings that need to be configured before you can start using Change
Automation.

Configuring Change Automation settings is a post-installation activity, and can only be performed by a user
with write permissions for the Administration APIs under Change Automation (Go to Administration >
Users and Roles > Roles).

Note

The Change Automation settings can only be configured once. If you want to modify the settings, Change
Automation must be re-installed.

Note

After Change Automation is installed in your Crosswork platform, you can access Change Automation from
the main menu (go to Network Automation > Dashboard). The Change Automation window is displayed
prompting you to complete the configuration. Click Start Configuration to review the change Automation
settings. Alternatively, you can navigate to Administration > Settings > Device Override Credentials to
view the settings.

Figure 6: Change Automation settings

Click Save after you configure the following settings:

• Playbook Job Scheduling: Enable or disable the ability the schedule the Playbook jobs.

• Credential Prompt: Device override credentials are an additional level of authentication that can improve
change auditing. If enabled, users will be prompted to enter the credentials (device override credentials)
before each Playbook execution. You need to create the relevant credential profile and provider settings
for the override credentials to work. Follow the prompts on the window to meet each requirement.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
24

Automate Network Changes
Configure Change Automation Settings



If Playbook Job Scheduling is disabled, then the Credential Prompt is enabled, by default. You cannot
disable the credential prompt in this case.

Note

While executing Device Config plays, entering incorrect device override credentials will cause the playbook
execution to fail. However, for a Check play or Data Collection play, the device override credentials are not
validated and the Playbook will execute successfully irrespective of the accuracy of the override credentials.
Device override credentials are only validated while pushing configuration changes.

Note

Use the Change Automation Dashboard
The Change Automation application's Dashboard window (shown in the following figure) lets you view all
Playbook-related activity and initiate Playbook runs. It displays the total number of Playbooks, the Playbook
Jobs Calendar, the most recently run Playbook jobs, and the same network topology map you see when you
select Topology from the main menu.

To view the Change Automation Dashboard window, select Network Automation > Dashboard.

Figure 7: Change Automation Dashboard Window

The Playbooks tile displays the total number of Playbooks (pre-defined and custom). Clicking on a specific
number displays all the Playbooks that correspond to the selected category.

My Playbooks indicate the number of custom Playbooks created by the current user. However, the Total
Playbooks will include the number of custom Playbooks created by all users, apart from the Cisco-supplied
Playbooks.

Note

The Jobs Calendar tile displays a calendar (month, week, day) with the number of job sets executed on a
given day marked in a circle against the corresponding date. Clicking on the number displays a dialog box
with the names of the Playbook job sets and their execution time. Click on the desired job set to view the
execution details.
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The color of the circle indicates the overall status of the job sets.

• A red circle indicates at least one job set with Failed status among the day's overall job sets.

• A grey circle indicates that all job sets are either in Scheduled or Running status.

• A blue circle indicates at least one critical job set in Recovered status among the day's overall job sets

Note

The View All Jobs link on the Jobs tile give you direct access to the Change Automation Automation Job
History window.

View the Play list
The Play List window of the Change Automation application gives you a consolidated list of all the Plays in
the system.

From the main menu, select Network Automation > Play List to view the Play List window.

DescriptionItem

Click to create a custom Play. See Create a Custom Play, on page 28.1

Click to delete a custom Play. See Delete Custom Plays, on page 32.

Click to import custom Play from a gzipped TAR archive file. See Import Plays, on page 32.

Click to export a custom Play as a gzipped TAR archive file. See Export Plays, on page 31.

Click to see a popup Play Details window showing the Play's description and schema. When
you are finished viewing these details, click to close the popup window.

2

The Type column indicates the type of the Play. You can click on the column headings (Name,
Description, Type, Labels, and Modified by) to sort the table by that column's data.

3
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DescriptionItem

Click to refresh the Plays list.4

Click to set filter criteria on one or more columns in the table.5

Click the Clear Filter link to clear any filter criteria you may have set.

View the Playbook List
The Change Automation application'sPlaybook Listwindow (in the following figure) gives you a consolidated
list of all the Playbooks in the system. To view the Playbook List window, select Network Automation >
Playbook List.

DescriptionItem

Click to create a custom Playbook. See Create a Custom Playbook, on page 35.1

Click to delete the currently selected custom Playbook. See Delete Custom Playbooks, on
page 40.

Click to import Playbooks from a gzipped TAR archive file. See Import Playbooks, on page
39.

Click to export the currently selected Playbook(s) as a gzipped TAR archive file. See Export
Playbooks, on page 38.

Click to see a popup Playbook Details window showing the Playbook's description, software
compatibility, version number, and its plays. When you are finished viewing these details, click
to close the popup window.

2

Click on the Name, Description, Version, Software Platform, and Last Modified column
headings in the table to sort the table by that column's data. You can also choose which columns
are shown, and set quick or advanced filters on any column.

3

Click to refresh the Playbooks list.4
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DescriptionItem

Click to set filter criteria on one or more columns in the table.5

Click the Clear Filter link to clear any filter criteria you may have set.

About Custom Plays
Change Automation allows users to create their own custom Plays, either based on Cisco models or from
scratch. Users can also import, export and delete their custom Plays.

Cisco-supplied Plays cannot be edited, exported or deleted by the user.Note

You can create custom Plays in any of the following types:

• Check Plays: Verifies the data from your devices using a logical expression.

• Data Collection Plays: Collects data from your devices.

• Device Config Plays: Performs configuration changes on your device

• Service Plays: Provisions and manages a service deployed

Check Play and Data Collection Play support MDT and SNMP collection.Note

Create a Custom Play
This section explains the procedure to create a custom Play. The stages of Play creation will vary depending
on the Play type you choose:

• Check Play: Select Play Type > Select Sensor Path > Build Check Expression > Review Play

• Data Collection Play: Select Play Type > Select Sensor Path > Build Filter Expression > Review Play

• Device Config Play or Service Play: Select Play Type > Configure Play (using sample payload in .JSON
format) > Review Play

When creating a Service Play, you are not creating a new service for NSO, but creating a Play to manage and
provision an existing service in one or more NSO instances.

Note

Step 1 From the main menu, choose Network Automation > Play List. The Play List window is displayed.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
28

Automate Network Changes
About Custom Plays



Step 2 Click to create a custom Play. The Select Play Type window opens displaying the types of Plays supported and a
description for each. The stages of creation is also displayed, and it will vary depending on the Play type you select.

Select the Play type you want to create and click Next.

Step 3 If you are creating a Check Play or Data Collection Play, perform the following:
a) In the Select Sensor Paths window, select the required YANG module, Gather Path, and Sensor Paths. Click Next

to continue.

b) Depending on the Play type you have selected, you need to Build Check (for Check Play) or Build Filter (for Data
Collection Play) to apply in your Play. Click Add Rule to add a logic expression using the keys and fields of the
selected sensor path(s). Click Add Group to add a new logic group. Select the sensor field, operator and value from
the dropdown lists. Select the desired logic operation (AND/OR) between each rule or group.

Click on Runtime checkbox if you prefer to enter the value of the sensor field dynamically during runtime. If you
select this checkbox, the value field is disabled, and you will be prompted to enter the input parameter when this Play
is executed (as part of a Playbook) during runtime.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
29

Automate Network Changes
Create a Custom Play



Click Next to continue.

Step 4 If you are creating a Device Config Play or Service Play, perform the following:

a) In the Configure Play window, click or the Import link to import your device config (.JSON) file. You can
download and use the sample configuration template. Browse and select your .JSON file, and click Import.

b) In the acknowledgement prompt, click Continue to select the NSO instance for the config you have imported.
c) Select the NSO provider instance from the dialog box, and click Process Payload.

The creation workflow of a Service Play is similar to the Device Config Play, except in the template of
the payload file used.

Note

d) TheConfigure Playwindow opens displaying information from the payload file. You can edit the value or description
columns with the values that you want to see during a Playbook execution.
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Click Next to continue.

Step 5 In the Review Play window, review the parameters of your Play. Click Dry Run to validate your parameters.

Label your Play with a unique Name and Description. You can also add labels to your Play to group it in the future
(optional).

Step 6 If you are satisfied with your changes, click Create.

The Play List window opens displaying your new custom Play in the Play list.

Export Plays
You can export any custom Play authoured by you or another user, or have imported into Cisco Crosswork
Change Automation and Health Insights.

The exported archive will contain only the user-customizable files listed in Playbook Components and Files,
on page 33. Once you extract them from the archive, you can identify the Play components by their file names
and filename extensions.
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Your user ID must have Change Automation read permission to export Plays.

Step 1 From the main menu, choose Network Automation > Play List.
Step 2 Check the check boxes for the custom Plays you want to export.

Step 3 Click . Your browser will prompt you to select a path and the file name to use when saving the gzipped tar archive.
Follow the prompts to save the file.

Import Plays
You can import any custom Play that meets the following requirements:

• The Play files must be packaged as a gzipped tar archive.

• The archive must contain a .play file (a data spec file for the play), at minimum.

• The archive file must have a unique name.

Note that you can overwrite a custom Play. The system will warn you when you are about to overwrite a
custom Play, but will not prevent you from doing so. Take precautions to ensure that you do not overwrite
your custom Plays accidentally.

Your user ID must have Change Automation write permissions to import Plays.

Step 1 From the main menu, choose Network Automation > Play List.

Step 2 Click . Your browser will prompt you to browse to and select the gzipped archive file containing the Plays you want
to import.

Make sure there is no existing Plays with the same name as the Play you intent to import, unless it is your intent to
overwrite the existing custom Play.

Step 3 Follow the prompts to import the archive file.

Delete Custom Plays
You can delete user-defined Plays only. You cannot delete a Cisco-supplied Play.

Your user ID must have Change Automation delete permission to delete Plays.

Step 1 From the main menu, choose Network Automation > Play List.
Step 2 In the Play List window, select the custom Plays that you want to delete.

Step 3 Click icon.
Step 4 When prompted, click Delete again to confirm.
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About Customizing Playbooks
Users can download and customize Cisco-supplied Playbooks, or create their own based on Cisco models or
from scratch. They can also create custom Playbooks using the available Plays.

Creating and modifying Cisco-supplied Playbooks are engineering tasks that take place outside of the user
interface for Cisco Crosswork Change Automation and Health Insights. As such, they are outside the scope
of this User Guide.

Cisco supplies developer-level documentation for Cisco-supplied Playbooks, Cisco verbs used in these
Playbooks, and tutorials on how to create custom plays and Playbooks. For help, see the:

• "Playbooks" and "Verbs" references in the Change Automation Developer Guide on Cisco Devnet

• "Custom Playbooks" tutorial in the Change Automation Developer Guide on Cisco DevNet

Playbook Components and Files
Change Automation Playbooks contain a variety of components, referred to using specialized names. The
components are implemented in the Playbook as files. Some of these components' names are borrowed from
the Ansible specification, but all have their own definitions, and not all of the corresponding files can be
customized by users. Some components are Cisco-proprietary intellectual property; while you can use them
in custom Plays and Playbooks, you cannot customize them directly. The following table explains the function
of each of these components, explains how they are implemented, and shows which of them you can customize.

Table 1: Playbook Components and Files

Customizable?File/FormatDescriptionComponent

YesYAML/YML in
the Playbook file

A Play is a single task to be executed. A
task is a list of actions to be performed in
service of that play. A Play is typically a
script that uses one or more verbs.

Play

YesYAML/YML fileA Playbook is an aggregation of one or
more Plays, and is structured by the plays
it contains. There can be many plays inside
a Playbook. The function of a Playbook is
to map a set of actions onto the features of
a particular host. For example: A query and
configuration change script with abstract
variables that can be mapped to a particular
instance of a device. For more details, see
the "Playbooks" and "Verbs" references in
the Change Automation Developer Guide
on Cisco Devnet.

Playbook
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Customizable?File/FormatDescriptionComponent

NoBinary executable
file

A verb is a Cisco-supplied module, and
functions as a granular unit of activity.
These are Cisco intellectual property,
supplied as object code, used under license
and not modifiable by users. For more on
Cisco verbs and how to use them, see the
"Custom Playbooks" tutorial in the Change
Automation Developer Guide on Cisco
DevNet.

Verb

YesJSON fileParams are simply variables, used in
Playbooks just as variables are used in any
programming language. A Params file in a
Playbook is an optional file that collects all
the user-defined input variables in one place.
It is optional because all these variables are
also in the plays.

Params

YesJSON Schema fileShort for "specifications", specs are Cisco
verb-specific object files, written in JSON
schema format. They define all the Playbook
input parameters and their constraints.

Specs

No, but you select
from the predefined
tag set.

Binary Executable
files

Tags are predefined phases of execution for
plays within a Playbook, and define the
order of execution of all plays:

• Continuous

• Pre-Maintenance

• Maintenance

• Post-Maintenance

Any play tagged as Continuous or runs in
parallel with other plays with the same tags.
All plays tagged as Maintenance or
Post-Maintenance run serially. Some
Pre-Maintenance plays ( check plays which
use the Crosswork Data Gateway
collections) run in parallel, while other
Pre-Maintenance plays run once the
concurrent plays have run successfully.
These tags are Cisco intellectual property,
used under license and not modifiable by
users.

Tags

NoYAML/YML fileA role is a built-in wrapper for Cisco’s
verbs. These files are Cisco intellectual
property, used under license and not
modifiable by users.

Role
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Create a Custom Playbook
Change Automation allows users to custom Playbooks using the available Plays.

You cannot edit a custom Playbook. If you need to make changes to a custom Playbook, you have to recreate
your Playbook with the relevant changes.

Note

To create a custom Playbook, follow the below procedure:

Step 1 From the main menu, choose Network Automation > Playbook List. The Playbook List window is displayed.

Step 2 Click to create a custom Playbook. The Select Plays window opens displaying the available Plays. The stages of
creation is also displayed, and it will vary depending on the Play type you select.

Select all the Plays you want in your Playbook, and click Next.

Step 3 In the Order Playbook window, arrange the order of the Plays in the Playbook as per the execution phase (Continuous,
Pre-maintenance, Maintenance, Post Maintenance). You can click and drag the play to rearrange them in the sequence
you prefer. You can also duplicate or delete a play by clicking on the icons provided.
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By default, all the selected plays are displayed within the Maintenance phase. Depending on the type of Play
you have selected, it may be restricted in being used in certain phases. For example, a configuration Play
cannot be used outside of the maintenance phase.

Note

Click Next to continue.

Step 4 TheConfigure Playswindow opens displaying the Plays in each execution phase, and the Play schemas. You can perform
the following:

• Click to specify policy for a Play. In the Specify Policy dialog box, specify relevant values for the fields provided.

Click for more information about each field. Click Save to save your policy values.
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Note Policies are mainly applicable to Check Plays. When you specify a custom policy for a Check play, you
must select the Required and Consecutive checkboxes, as shown in the image below. If you fail to do
so, the Change Automation collection jobs may not get deleted at the end of the Playbook execution.

Figure 8: Specify Policy for Check Play

• Click to apply a conditional to a Play. During execution, the play execution will be proceeded only if the condition
is met. In the Specify Conditionals dialog box, click Add Condition to add a conditional. Click Save to save your
conditional values.

• Click to specify a register for a Play. Specifying registers allow you to use the output of a previous Play as the
input for another Play. Click Save to save your registers.

• (Optional) Rename the plays as how you want it to be displayed during the Playbook execution.

Click Next to continue.

Step 5 In the Review Playbook window, review the Plays in your Playbook. Enter relevant values for the Playbook details

fields. You can click for more information about each field.
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Step 6 (Optional) After you enter the relevant details, click Dry Run to validate the parameters. A dialog box opens displaying
the Playbook Details.

Step 7 Click Create to create the Playbook.

The Playbook List window opens displaying your new custom Playbook in the list.

Export Playbooks
You can export any Playbook as a gzipped tar archive. This includes any Cisco-supplied Playbook, as well
as custom Playbooks that you or another party have authored and have imported into Cisco Crosswork Change
Automation and Health Insights.
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The exported archive will contain only the user-customizable files listed in Playbook Components and Files,
on page 33. The archive will contain one of more .pb files (for example: router_config_bgp_rd.pb
for the Playbook code), which are parsed and processed at the backend.

You can edit the exported files as needed, following the guidelines in the "Custom Playbooks" tutorial in the
Change Automation Developer Guide on Cisco DevNet. You can then import them as explained in Import
Playbooks, on page 39.

You cannot re-import an exported Cisco-supplied Playbook with the same name as the original.

Your user ID must have Change Automation read permission to export Playbooks.

Step 1 From the main menu, choose Network Automation > Playbook List.
Step 2 (Optional) In the Playbook List window, filter the table as needed.
Step 3 Check the check boxes for the Playbooks you want to export. Check the check box at the top of the column to select all

of the Playbooks for export.

Step 4 Click . Your browser will prompt you to select a path and the file name to use when saving the gzipped tar archive.
Follow the prompts to save the file.

Import Playbooks
You can import any custom Playbook, provided it meets the following requirements:

• The Playbook files must be packaged as a gzipped tar archive.

• The archive must contain a .pb file, at minimum.

• The archive file must have a unique name.

The individual files included in the archive must meet the additional validation requirements described in the
"Custom Playbooks" tutorial in the Change Automation Developer Guide on Cisco DevNet.

While you cannot overwrite a Cisco-supplied Playbook, you can overwrite a custom Playbook. The system
will warn you when you are about to overwrite a custom Playbook, but will not prevent you from doing so.
Take precautions to ensure that you do not overwrite your custom Playbooks accidentally.

Note

Your user ID must have Change Automation write permissions to import Playbooks.

Step 1 From the main menu, choose Network Automation > Playbook List.

Step 2 Click . Your browser will prompt you to browse to and select the gzipped archive file containing the Playbooks you
want to import.

Make sure there is no existing Playbook with the same name as the Playbook you intent to import, unless it is your intent
to overwrite the existing Playbook.

Step 3 Follow the prompts to import the archive file.
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Delete Custom Playbooks
You can delete user-defined Playbooks only. You cannot delete a Cisco-supplied Playbook.

Your user ID must have Change Automation delete permission to delete Playbooks.

Step 1 From the main menu, choose Network Automation > Playbooks List.
Step 2 In the Playbooks List window, select the custom Playbook that you want to delete.

Step 3 Click icon.
Step 4 When prompted, click Delete again to confirm.

About Running Playbooks
Running any Playbook consists of five steps:

1. Select the Playbook you want to run (see View the Playbook List, on page 27).

2. Select the device or devices you want to run it on.

3. Enter the appropriate runtime parameters you want the Playbook to apply.

4. Select the execution mode you want to use:

a. Perform a Dry Run of a Playbook, on page 41, where you can see what the Playbook will do before
you commit to making changes to the network.

b. Run Playbooks In Single Stepping Mode, on page 43, so you have a chance to pause after each
Playbook check or action, and roll back changes you did not intend.

c. Run Playbooks In Continuous Mode, on page 46 and apply the changes immediately.

While selecting the execution mode, you can also choose to:

• Schedule Playbook Runs, on page 49 for another calendar date or time.

• Collect syslogs during and after the run. Syslog collection is available only when running the Playbook
in single-stepping or continuous execution mode, and only if you have already configured a syslog
storage provider.

• Specify a Failure Policy, where you decide what the system should do in case a failure occurs at
any time during the Playbook run.

5. Confirm your settings and run the Playbook in the execution mode you selected.

Depending on their complexity and on network factors, some Playbooks may take a lot of time to run. At any
time during and after completion of a run, you can view the run details and status. If the Playbook is still
running, you can also choose to abort it. For details, see View or Abort Playbook Jobs, on page 50.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
40

Automate Network Changes
Delete Custom Playbooks



Playbook Execution Order
When it is running, every Playbook conducts checks and configuration changes in four phases, which correspond
to sections of the Playbook code (identified using the tags discussed in Playbook Components and Files, on
page 33):

1. Pre-Maintenance—This phase of the Playbook includes non-disruptive checks and any other operations
on the device that prepare it for potentially traffic-impacting changes. For example:

• Take snapshots of various routing protocol states.

• Take snapshots of memory, CPU, and system health parameters.

• Validate the capacity (storage, memory) on active and standby routers for the new software patch
upgrade.

2. Maintenance—This phase of the Playbook includes any task that may disrupt traffic flowing through the
router or impact neighboring routers. For example:

• Cost out the router and wait until traffic drains out completely.

• Verify that the redundant router is healthy and carrying traffic.

• Perform the upgrade procedure on the device.

• Reconfigure the device(s) to support a new configuration or feature.

3. Post-Maintenance—This phase of the Playbook includes verification tasks to perform on the router after
any disruptive operation. For example:

• Verify that the current state matches the desired state.

• Cost in the router and wait for traffic to return to normal levels.

4. Continuous—In addition to the three serial phases already described, Change Automation also runs check
tasks that span the entire duration of Playbook execution. These tasks check the state of the router while
the Playbook is being deployed, and cancel the Playbook execution if any catastrophic or undesirable
state change occurs. The checks in the Playbook may also monitor a neighboring router to guarantee that
there are no second-order failures in the network while the changes are being deployed.

Perform a Dry Run of a Playbook
A dry run lets you view configuration changes that the Playbook will send to the device, without performing
the actual commit of the changes, as you would with a run in the single-stepping or continuous execution
modes.

It is a best practice to perform a dry run and verify the configuration changes before you deploy those changes
to the router. If the dry run fails, you may want to debug its parameter values using another dry run. You can
also debug by performing a single-stepping run, which will allow you to abort and rollback changes after one
or more of the plays, instead of only at the end, as part of a continuous run's Failure Policy.

Note that dry run mode is intended for use only with Playbooks that perform actual device configuration
changes via Cisco NSO. See the "Playbooks" and "Verbs" references in the Change Automation Developer
Guide on Cisco Devnet for details on Playbooks that do not support dry run mode. These will include, for
example, Node state snapshot, Install optional package or SMU, and Uninstall optional package or SMU.
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Step 1 From the main menu, choose Network Automation > Run Playbook.
Step 2 In the Select Playbook list on the left, click on the Playbook you want to dry run. On the right, the window displays

the Playbook name, hardware and software compatibility information, and descriptions for all the plays in the selected
Playbook.

Step 3 Click Next. The Select Devices window appears. Using this window:

• You can toggle between the table view and topology map view by clicking and selecting the relevant option on
the drop-down button on the upper left corner of the window. Choose Select Devices From List or Select Devices
From Map to select the table view or topology map view respectively. By default, the table view is displayed.

• With the topology map view displayed, you can toggle between the map's geographical and logical views by

clicking on the or the . You can also zoom, display bandwidth utilization, and change logical view layouts
as you do with the topology map you see when you select Topology from the main menu.

• You can select the devices using Static or Dynamic using Tags device selection options. Static selection allows
you to select devices from the list using quick and advanced filters and filter by tags on the left. Dynamic using
Tags selection targets you to select the relevant tag intead of devices from the table on the left side, and all devices

associated with the relevant tag are selected. Hover the mouse pointer over the icon next to the options for
more information. You can also view the selection criteria such as number of devices required for the selected
playbook.

• In Static selection mode, you can check the Allow Bulk Jobs check box to select multple devices and run the
selected playbook on them at the simultaneously. Based on your selection, the system creates a static group of

multiple jobs. Hover the mouse pointer over the icon next to the check box for more information. There is no
limitation on the number of devices you can select for a bulk job.

Allow Bulk Jobs option is enabled for playbooks that can be executed on a single device.Note

Step 4 The Select Devices window will prompt you to select one or more of the devices shown (depending on the Playbook).
Click on the devices you want to select, then click Next. The Parameters window appears.

Step 5 In the fields provided in the Parameters window, enter the Playbook parameter values to use for this dry run.

With the Parameters window displayed, you can also:

• Click JSON to enter the parameter values in JSON format. A popup text window displays the full list of JSON
parameters, with empty values in quotes. Edit the values and, when you are finished, click Save.

• Click to upload a JSON file with the parameter values you want. You will be prompted to navigate to the JSON
parameters file you have previously prepared (or downloaded from a previous Playbook run) and then upload it
as appropriate for your browser and operating system.

• Click + Add to add additional instances of a particular parameter, if required for the Playbook you are running.
Click X Remove to delete instances added in this way.

• Click to clear all the parameter values entered so far.

Step 6 With the parameter values set, click Next. The Execution Policy window appears.
Step 7 Choose Dry Run and click Next. The Review your Job window appears, displaying a summary of all of your choices:

playbook, devices, parameters, and execution policy. In this window:

• You must provide a relevant Name for the job.
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• You can assign tags to your job. Click New Job Tag, provide a name and color and save your settings to create
your own tag. You can also select from the list of existing job tags by clicking the corresponding checkboxes.
Click Manage Job Tags to create, edit or delete job tags.

• You can click on any of the Change links in the Review your Job window summary to modify your choices.

Step 8 (Optional) Enter the device credentials (name and password).

This step is applicable only if Credential Prompt is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings, on page 24.

Note

Step 9 When you are ready to continue, click Run Playbook.
Step 10 At the confirmation prompt, click Confirm. The Execution Mode window is displayed.
Step 11 After the dry run is complete:

• Click the Dry Run tab and verify the configuration changes that would be pushed to the device had this not been
a dry run. This tab will display a no config change message if no changes would have been made. Please
note that this tab shows only cumulative configuration changes, not each individual change made. For example,
if a Playbook configures set-overload-bit in one step and then unconfigures it using no set-overload-bit in
a later step, the tab will show no config change.

• Click theEvents tab to see success and failure messages for each step of the Playbook. This can help you diagnose
and correct problems with individual plays and the run as a whole.

• Click the Console tab to see messages that are generated during the run.

As syslog collection is disabled for drying runs, the Syslog tab will contain only a message stating that.

Step 12 (Optional) If you want to perform a single-step debugging run, or are ready to commit the changes to the device, click
Execute Now. TheExecution Policywindowwill display, with all of your parameter values from the dry run pre-filled.

Run Playbooks In Single Stepping Mode
Single-stepping execution mode is a handy way to test a custom or modified Playbook, or diagnose problems
with a pre-packaged Playbook that is not giving you the results you want. Unlike a dry run, a single-stepping
execution commits configuration changes to the device as the Playbook runs. However, you can set breakpoints
on or pauses after any Maintenance or Post-Maintenance action in the Playbook. Please note that, while you
can set breakpoints on Pre-Maintenance actions, doing so will have no effect, and these actions will not pause.

Whenever the Playbook hits a breakpoint, it will stop, and will not continue until you issue the command to
proceed. At each pause, you can also choose to abort the entire run and roll back all changes made, or rollback
to any previous play.

Step 1 From the main menu, choose Network Automation > Run Playbook.
Step 2 In the Select Playbook list on the left, click on the Playbook you want to run. On the right, the window displays the

Playbook name, hardware and software compatibility information, and descriptions for all the plays in the selected
Playbook.

Step 3 Click Next. The Select Devices window appears. Using this window:
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• You can toggle between the table view and topology map view by clicking and selecting the relevant option on
the drop-down button on the upper left corner of the window. Choose Select Devices From List or Select Devices
From Map to select the table view or topology map view respectively. By default, the table view is displayed.

• With the topology map view displayed, you can toggle between the map's geographical and logical views by

clicking on the or the . You can also zoom, display bandwidth utilization, and change logical view layouts
as you do with the topology map you see when you select Topology from the main menu.

• You can select the devices using Static or Dynamic using Tags device selection options. Static selection allows
you to select devices from the list using quick and advanced filters and filter by tags on the left. Dynamic using
Tags selection allows you to select the relevant tag from the table on the left side, and all devices associated with

the relevant tag are selected. Hover the mouse pointer over the icon next to the options for more information.
You can also view the selection criteria such as number of devices required for the selected playbook.

• In Static selection mode, you can check the Allow Bulk Jobs check box to select multple devices and run the
selected playbook on them at the simultaneously. Based on your selection, the system creates a static group of

multiple jobs. Hover the mouse pointer over the icon next to the check box for more information. There is no
limitation on the number of devices you can select for a bulk job.

Allow Bulk Jobs option is enabled for playbooks that can be executed on a single device.Note

Step 4 The Select Devices window will prompt you to select one or more of the devices shown (depending on the Playbook).
Click on the devices you want. Click Next.

Step 5 Click Next. The Parameters window appears.
Step 6 In the fields provided in the Parameters window, enter the Playbook parameter values to use for this run.

With the Parameters window displayed, you can also:

• Click JSON to enter the parameter values in JSON format. A popup text window displays the full list of JSON
parameters, with empty values in quotes. Edit the values and, when you are finished, click Save.

• Click to upload a JSON file with the parameter values you want. You will be prompted to navigate to the JSON
parameters file you have previously prepared (or downloaded from a previous Playbook run) and then upload it
as appropriate for your browser and operating system.

• Click + Add to add additional instances of a particular parameter, if required for the Playbook you are running.
Click X Remove to delete instances added in this way.

• Click to clear all the parameter values entered so far.

Step 7 With the parameter values set, click Next. The Execution Policy window appears.
Step 8 Choose Single Stepping. The Execution Policy window displays additional features to customize the job:

• Under Collect Syslogs, click Yes if you want syslogs to be collected during and immediately after the run, No if
you do not. Yes is the default selection only if you have a syslog provider configured.

• From the Failure Policy dropdown, select:

• Abort to abort the entire run, without rolling back any changes, if a failure occurs at any point. This is the
default. Any configuration changes made up to the point of failure will not be rolled back.

• Pause to pause the run and allow you to decide how to handle the failure. This pause will be in addition to
any breakpoints you set using the Single stepping breakpoints dropdown.

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
44

Automate Network Changes
Run Playbooks In Single Stepping Mode



• Complete Roll Back to abort the entire run and roll back all configuration changes made.

• In the Schedule area, uncheck the default Run Now selection to schedule the job for a later time. See Schedule
Playbook Runs, on page 49 for help on using the Schedule area features

Step 9 From the Single stepping breakpoints dropdown, select either

• Every step to pause automatically after every step in the Playbook.
• Customize to select the steps where you want the Playbook to pause.

If you selectCustomize, the Customize Breakpoints popup displays a list of all the plays in the Playbook, with a at

the step between each play. Click the at each step where you want to set a breakpoint. When you are finished, click
Done.

Step 10 Click Next. The Review your Job window appears, displaying a summary of all of your choices: playbook, devices,
parameters, and execution policy. In this window:

• You must provide a relevant Name for the job.

• You can assign tags to your job. Click New Job Tag, provide a name and color and save your settings to create
your own tag. You can also select from the list of existing job tags by clicking the corresponding checkboxes.
Click Manage Job Tags to create, edit or delete job tags.

• You can click on any of the Change links in the Review your Job window summary to modify your choices.

Step 11 (Optional) Enter the device credentials (name and password).

This step is applicable only if Credential Prompt is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings, on page 24.

Note

Step 12 When you are ready to continue, click Run Playbook.
Step 13 At the confirmation prompt, click Confirm. The Automation Job History window is displayed, with the details of

the current job displayed on the right side. The job details include information such as job status, job set tags, title of

selected playbook, execution parameters and policy, last updated date and update comments (if any). Click the icon
next to the detail to view more information.

Step 14 While the run is executing, the blue Running tile at the top of the window will change to Paused for each step at which
you have set a breakpoint. Your choices at each pause will be displayed as buttons below the blue tiles:

• Click Resume to resume running from this point, with no changes. The Resume request includes the runtime
parameters from the previous step; you can edit these, as needed, later.

• Click Roll Back to roll back any changes made so far. You can choose how far to rollback:

• Click Complete Roll Back to roll back all changes to the start of the Playbook run. Once you have rolled
back to the start, you can choose to Resume from that point, Abort the run entirely, or Edit runtime
parameters of the run.

• Click Select Roll Back Point to roll back changes to the step you select. All the previous steps will then have
a roll back point icon displayed next to them: . Click the for the step to which you want to roll back.
Once you have selected the step, you can choose to Resume from that step, Roll Back further, Abort the
run entirely, or Edit runtime parameters.

• Click Abort to abort the run entirely. No changes made will be rolled back.
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• Click Edit runtime parameters to edit the parameters the run is using. You edit using a popup version of the
Parameters window, just as you did in step 6. The parameters exposed for editing when resuming are specific to
the task being resumed, which means that they are not the same global parameters you defined in step 6. Most of
the time, they are a subset of the global parameters. When you are finished, click Apply. You can then choose to
Resume execution with the changed parameters.

Step 15 While the run is executing, you can also use the following features of the progress window:

• View the execution status of each play in the Playbook in the Maintenance play list at the left side of the window.
Plays that fail are indicated with a red icon; plays that succeed are indicated with a green icon.

• See reminders of your choices in the blue Playbook and Devices tiles at the top of the window.

• See the current status of the run in the blue Running tile at the top of the window.

• Click View in the Parameters tile to view the run's parameters. While viewing the parameters, you can click
Download Parameters to save them in a JSON file. You will be prompted to name and save the file as appropriate
for your browser and operating system.

• Use the network topology in the map at the right side of the window to view the device and its connections to the
rest of your network.

Step 16 After the run is complete:

• Click theEvents tab to see success and failure messages for each step of the Playbook. This can help you diagnose
and correct problems with individual plays and the run as a whole.

• Click the Syslogs tab to access syslogmessages collected during and immediately after the run. If syslog collection
is enabled, the tab will provide a pointer to the path on the syslog storage provider where collected syslogs are
stored. If you chose not to collect syslogs, or no syslog storage provider has been configured, this tab will display
a message indicating that syslog collection is disabled.

• Click the Console tab to see relevant commands and responses from the device consoles that took place during
the run. These messages can also help with diagnostics.

Run Playbooks In Continuous Mode
Continuous execution mode is the standard way to run Playbooks. Configuration changes are committed to
the device during the run, with no checks or delays except those programmed into it for system resets or other
purposes. The run continues until it succeeds or fails. If it fails, you can use the run's Failure Policy to abort,
rollback all changes made to the device, or pause execution at the failure point.

It is always good practice to perform a dry run and verify the configuration changes before committing to a
continuous run (see Perform a Dry Run of a Playbook, on page 41). You can also run the Playbook in
single-stepping mode, which will allow you to pause execution after any play you select, abort and rollback
changes as needed, and even change runtime parameters in the middle of the run (see Run Playbooks In Single
Stepping Mode, on page 43).

Step 1 From the main menu, choose Network Automation > Run Playbook.
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Step 2 In the Select Playbook list on the left, click on the Playbook you want to run. On the right, the window displays the
Playbook name, hardware and software compatibility information, and descriptions for all the plays in the selected
Playbook.

Step 3 Click Next. The Select Devices window appears. Using this window:

• You can toggle between the table view and topology map view by clicking and selecting the relevant option on
the drop-down button on the upper left corner of the window. Choose Select Devices From List or Select Devices
From Map to select the table view or topology map view respectively. By default, the table view is displayed.

• With the topology map view displayed, you can toggle between the map's geographical and logical views by

clicking on the or the . You can also zoom, display bandwidth utilization, and change logical view layouts
as you do with the topology map you see when you select Topology from the main menu.

• You can select the devices using Static or Dynamic using Tags device selection options. Static selection allows
you to select devices from the list using quick and advanced filters and filter by tags on the left. Dynamic using
Tags selection allows you to select the relevant tag from the table on the left side, and all devices associated with

the relevant tag are selected. Hover the mouse pointer over the icon next to the options for more information.
You can also view the selection criteria such as number of devices required for the selected playbook.

• In Static selection mode, you can check the Allow Bulk Jobs check box to select multple devices and run the
selected playbook on them at the simultaneously. Based on your selection, the system creates a static group of

multiple jobs. Hover the mouse pointer over the icon next to the check box for more information. There is no
limitation on the number of devices you can select for a bulk job.

Allow Bulk Jobs option is enabled for playbooks that can be executed on a single device.Note

Step 4 The Select Devices window will prompt you to select one or more of the devices shown (depending on the Playbook).
Click on the devices you want to select them, then click Next. The Parameters window appears.

Step 5 In the fields provided in the Parameters window, enter the Playbook parameter values to use for this dry run.

With the Parameters window displayed, you can also:

• Click JSON to enter the parameter values in JSON format. A popup text window displays the full list of JSON
parameters, with empty values in quotes. Edit the values and, when you are finished, click Save.

• Click to upload a JSON file with the parameter values you want. You will be prompted to navigate to the JSON
parameters file you have previously prepared (or downloaded from a previous Playbook run) and then upload it
as appropriate for your browser and operating system.

• Click + Add to add additional instances of a particular parameter, if required for the Playbook you are running.
Click X Remove to delete instances added in this way.

• Click to clear all the parameter values entered so far.

Step 6 With the parameter values set, click Next. The Execution Policy window appears.
Step 7 Choose Continuous. The Execution Policy window displays additional features to customize the job:

• Under Collect Syslogs, click Yes if you want syslogs to be collected during and immediately after the run, No if
you do not. Yes is the default selection only if you have a syslog provider configured.

• From the Failure Policy dropdown, select:

• Abort to abort the entire run, without rolling back any changes, if a failure occurs at any point. This is the
default. Any configuration changes made up to the point of failure will not be rolled back.
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• Pause to pause the run and allow you to decide how to handle the failure.

• Complete Roll Back to abort the entire run and roll back all configuration changes made.

• In the Schedule area, uncheck the default Run Now selection to schedule the job for a later time. See Schedule
Playbook Runs, on page 49 for help on using the Schedule area features

Step 8 Click Next. The Review your Job window appears, displaying a summary of all of your choices: playbook, devices,
parameters, and execution policy. In this window:

• You must provide a relevant Name for the job.

• You can assign tags to your job. Click New Job Tag, provide a name and color and save your settings to create
your own tag. You can also select from the list of existing job tags by clicking the corresponding checkboxes.
Click Manage Job Tags to create, edit or delete job tags.

• You can click on any of the Change links in the Review your Job window summary to modify your choices.

Step 9 (Optional) Enter the device credentials (name and password).

This step is applicable only if Credential Prompt is enabled in the Change Automation settings. For more
information, see Configure Change Automation Settings, on page 24.

Note

Step 10 When you are ready to continue, click Run Playbook.
Step 11 At the confirmation prompt, click Confirm. The Automation Job History window is displayed, with the details of

the current job displayed on the right side. The job details include information such as job status, job set tags, title of

selected playbook, execution parameters and policy, last updated date and update comments (if any). Click the icon
next to the detail to view more information.

Step 12 While the run is executing, the blueRunning tile at the top of the window will change to Paused if you chose a Failure
Policy of Pause. Your choices will be displayed as buttons below the blue tiles:

• Click Resume to resume running from this point, with no changes.
• Click Roll Back to roll back any changes made so far.
• Click Abort to abort the run entirely. No changes made will be rolled back.

Step 13 While the run is executing, you can also use the following features of the progress window:

• View the execution status of each play in the Playbook in the Maintenance play list at the left side of the window.
Plays that fail are indicated with a red icon; plays that succeed are indicated with a green icon.

• See reminders of your choices in the blue Playbook and Devices tiles at the top of the window.

• See the current status of the run in the blue Running tile at the top of the window.

• Click View in the Parameters tile to view the run's parameters. While viewing the parameters, you can click
Download Parameters to save them in a JSON file. You will be prompted to name and save the file as appropriate
for your browser and operating system.

• Use the network topology in the map at the right side of the window to view the device and its connections to the
rest of your network.

Step 14 After the run is complete:

• Click theEvents tab to see success and failure messages for each step of the Playbook. This can help you diagnose
and correct problems with individual plays and the run as a whole.
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• Click the Syslogs tab to access syslogmessages collected during and immediately after the run. If syslog collection
is enabled, the tab will provide a pointer to the path on the syslog storage provider where collected syslogs are
stored. If you chose not to collect syslogs, or no syslog storage provider has been configured, this tab will display
a message indicating that syslog collection is disabled.

• Click the Console tab to see relevant commands and responses from the device consoles that took place during
the run. These messages can also help with diagnostics.

Schedule Playbook Runs
The Change Automation application'sExecution Mode window allows you to schedule future Playbook runs
as jobs, and view all the jobs that have been scheduled. Use the Schedule area on the left to schedule a job.
Use the All Scheduled Jobs area on the right to view scheduled jobs on the calendar.

TheExecution Modewindow's scheduling features are only displayedwhen you have chosen to run a Playbook
in continuous or single-stepping mode. You cannot schedule a dry run of a Playbook.

Figure 9: Execution Mode Scheduling Features

DescriptionItem

Run Now: Running Playbooks immediately is the default for continuous and single-stepping
execution modes. To schedule a run for a future time and date, you must uncheck this box.

1

Schedule Selectors: Use these fields to select the future time and date when the Playbook
runs. Although it is the default for the Pre-Maintenance and Maintenance phases of a
scheduled Playbook to start at the same time, you can use the upper Schedule Pre-check
and lower Schedule Perform fields to schedule the start of Pre-Maintenance and the start
of Maintenance independently. Note that the Schedule Perform timemust always be greater
than or equal to the Schedule Pre-check time.

2
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DescriptionItem

Previous/Today/Next Selectors: Use these three selectors with the Month/Week/Day
selectors to focus the calendar's display of scheduled jobs on the time range in which you
are interested. For example: To show only those jobs scheduled for next week, click Next
and Week.

3

Job Icons: Red, numbered icons in the squares representing each calendar date show how
many jobs are scheduled for that date. Yellow circle icons represent each scheduled job.

4

Job Details Popup: Hover your mouse cursor over a yellow circle icon to see the details
for the scheduled job represented by that icon. The popup shows the execution ID of the job
and the name of the Playbook to be run.

5

Show jobs for selected devices only: Check this box to restrict the calendar display to only
those jobs scheduled to run on the devices you have already selected. This is a handy way
to see if the schedule you plan for your Playbook run will conflict with other scheduled jobs
on the same devices.

6

Month/Week/Day Selectors: Use these three selectors with the
Previous/Today/Nextselectors to focus the calendar's display of scheduled jobs on the time
range in which you are interested. For example: To show only those jobs scheduled for last
month, click Last and Month.

7

Change Automation Playbooks have a mop_timeout parameter, which is a user specified input needed to
schedule any Playbook. If you are scheduling a Playbook with Failure Policy set to Complete Roll
Back, you must double the value of the mop_timeout parameter as it can possibly take as much time to
roll back the Playbook as it takes to run it until the last step. For example, if Playbook timeout is typically set
to 1 hour, set it to 2 hours instead when enabling complete rollback on failure policy. Without sufficient
mop_timeout, the Playbook can end up in a bad state if the timeout gets triggered while roll back is in
progress.

Note

View or Abort Playbook Jobs
The Automation Job History window let you click on any individual job in the list to see that job's detailed
execution progress panel, which displays the name of the Playbook, its plays, the devices it ran on, the
parameters used, and all event, syslog, console and other messages. These details are useful when diagnosing
failures.

The Automation Job History window also allows you to abort running jobs.

You can also navigate to Automation Job History window from theJobs panel in the Change Automation
Dashboard.

Note

Step 1 From the main menu, select Network Automation > Automation Job History. The Automation Job History window
is displayed with a list of Job Sets.
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The list in Automation Job History window is sorted by the last update time, with running or most recently executed
jobs at the top. You can apply quick or advanced filters to the table as you would with columns in other table windows.

Step 2 To view information about a specific Playbook job, click the relevant job ID checkbox on the left. The job's status and

execution details are displayed on the right side. Click on the icon next to each detail to get more information about
the selected job set.

Step 3 You can abort a job set in running, paused or scheduled status, as follows:

• To abort a specific job, click the check box next to it and then click Abort Selected.
• To abort all jobs immediately, click Abort All.

When prompted, click Confirm. Jobs that are currently paused or scheduled will abort once the current task has run to
completion.

Troubleshoot Change Automation
The following table describes issues you may encounter when using the Change Automation application, and
their solutions or workarounds.

Table 2: Change Automation Troubleshooting

SolutionIssue

Run the Playbook again. Under normal circumstances,
doing so will initiate a sync operation between the
device and NSO. Alternatively, you can also perform
a sync-from or sync-to operation in NSO.

Playbook run fails withmessages indicating that Cisco
Network Services Orchestrator (Cisco NSO) and the
target device are out of sync or otherwise out of
communication. Message text will vary, but may
include "device out of sync", "NC client timeout",
and other text indicating that there are connectivity
or sync issues between Cisco NSO and the device.
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SolutionIssue

Include the below settings in the Cisco NSO
configuration file (ncs.conf):
<ssh>
<client-alive-interval>infinity</client-alive-interval>

<client-alive-count-max>5</client-alive-count-max>
</ssh>

"Failed to end NSO transaction,
500:fatal:YClientError: Failed to send RPC:" error
is displayed while running the playbook.

In the Devices window, select the relevant devices
and clear the lock by moving the device to DOWN
and then UP. Go to Administration > Crosswork
Manager, click the Change Automation tile and
restart the robot-nca process. Once the protocols are
reachable, you can schedule to run a new playbook.

Playbook aborted due to failure in locking the device
nodes.
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C H A P T E R 5
Monitor Network Health and KPIs

This section contains the following topics:

• Health Insights Overview, on page 53
• Manage KPIs, on page 59
• Manage KPI Profiles, on page 69
• Troubleshoot Health Insights, on page 76

Health Insights Overview
Health Insights is a network health application that performs real-time key performance indicator (KPI)
monitoring, analytics, alerting, and troubleshooting. Health Insights builds dynamic detection and analytics
modules that allow operators to monitor and alert network events with user-defined logic.

Health Insights provides prebuilt KPIs that are based on model-driven and SNMP-based telemetry. The Health
Insights Recommendation Engine uses data mining to analyze your network and then recommends which
telemetry paths you should enable and monitor.

For the recommendation engine to work in Health Insights, you need to ensure that direct connectivity is
established between Cisco Crosswork Change Automation and Health Insights and the device, and enable the
NETCONF protocol.

Note

The following high-level example shows how Health Insights interacts with the other Cisco Crosswork
Network Automation components:

1. Health Insights detects an anomaly: The optical bit error rate that you are monitoring on each of the links
in your network suddenly increases.

2. Change Automation Playbooks automate remediation: Switch to the backup link immediately. Restore
service. Open an ticket (manually initiated by the user). Alert the network engineer.

Any network remediation can be orchestrated via Change Automation Playbooks, which closes the loop
on problem detection and resolution.
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Health Insights Alert Dashboard
The Health Insights alert dashboard provides device health summary information that is based on real-time
network state events. The dashboard displays a network view of KPI sensors that are paired to specific device
groups. Health Insights raises customizable events and alerts that are based on user-defined logic.

Alert dashboard displays individual KPI alerts, even though the mechanism of enabling KPI on a device is
done through a KPI profile.

Note

To display the Health Insights dashboard, choose Performance Alerts > Alert Dashboard from the main
menu.

DescriptionItem

Device/KPI Alert Selector: Click here to toggle between device alert and KPI alert
information.

1

Alerts History: This dashlet shows the total number of device alerts or KPI alerts that have
been raised during the chosen time period, with detailed time lines showing both individual
sets of alerts and the overall alert trend.

2
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DescriptionItem

Alerts Trend Line: This line shows the overall trend in alerts for the chosen time period.
You can use the Alerts Trend Line to select and zoom in on a specific time period within
the Alerts History Line, as follows:

1. Click the time-period starting point in theAlerts Trend Line and hold down the mouse.

2. Drag the cursor to the endpoint and then release the mouse.

The time range you selected is indicated by light gray shading on the Alerts Trend Line,
with + and - zoom icons shown above the Alerts History Line. Click the + icon to zoom
in on the time range you selected. Click the - to zoom out. To restore the full view of the
Alerts History Line, click on any point outside of the light gray shading on the Alerts
Trend Line.

3

Top 20 Impacted Devices/ Top 20 Impacted KPIs: When selected, this dashlet displays
a map of tiles, each tile representing one of the 20 devices or KPIs with the most alerts
during the selected time period. The amount of space that each tile occupies in the map
corresponds to the number of alerts raised: the more alerts, the bigger the tile. To view more
detailed information for a particular device or KPI, click the device or KPI name link in the
center of the tile.

4

Filter By Tags: This field lets you filter the alert dashboard information by associated tag
names. To select a tag, do one of the following:

• If you know the tag that you want to use, enter it in the Type to filter by Tags field
and then check its check box. Repeat this step to select more tags.

• If you want to select a tag from the tags that are currently available:

1. In the Type to filter by Tags field, type any character to open the results list.

2. Click the View All Tags link at the bottom of the list.

3. Check the check box for each tag you want to use and then click Apply Filters.

4. Delete the character that you typed in Step 1 to clear the results list.

Tag filters you create are not saved. If you open another window and then return to the alert
dashboard, you will need to re-create tag filters.

5

Cisco Crosswork Change Automation and Health Insights 4.0 User Guide
55

Monitor Network Health and KPIs
Health Insights Alert Dashboard



DescriptionItem

All Impacted Devices/All Impacted KPIs: When selected, this dashlet provides a complete
list of all devices or KPIs affected by alerts. The information for each affected device or
KPI includes:

• Device Name or KPI Name

• Device or KPI Type

• IP address: The IP address of the impacted device. This column is only displayed for
devices.

• Alert count: The total number of alerts for that device or KPI during the selected period.

• Impact score—This value is determined using the following formula: (4 x number of
critical alerts) + (3 x number of major alerts) + (2 x number of minor alerts) + number
of warning alerts. When monitoring the health of your network, focus on devices or
KPIs with a higher impact score.

• Severity distribution—Provides a visual breakdown of the severity that is associated
with a device or KPI's alerts. To view a tooltip that indicates the number of raised
alarms (by severity and in total), place your cursor over the appropriate bar segment.

6

Alerts History: TheAlerts History line shows alerts as discrete bar indicators whose height
represents the total number of alerts gathered at each point in time. To see the total for each
type of alert, hover your mouse cursor over the bar indicator. You can also use the Alerts
Trend line to zoom in on particular portions of the alert history.

7

Time Period: Specifies the time period for which the dashboard provides alert information:
The past one hour, past day, past week, and so on. Please note that the dashboard provides
alert information only, not telemetry information.

8

Severity Legend: Maps the bar indicator colors that are used in the Alert History dashlet
to the corresponding alert severity. To display or hide the alerts for a particular severity,
click the circle representing that severity. A filled circle indicates that alerts of that severity
have been raised and are being displayed. An empty circle indicates that alerts of that severity
are either not being displayed or have not been raised during the displayed time period.

9

Auto Refresh: Specifies how often the dashboard is automatically refreshed.10

Refresh Icon: Refreshes the dashboard.11

• Alert group logic does not show the alerts impacted on dashboard, only API shows the impacted results.

• Composite Alerting is not displayed in the Alert dashboard.

Note

View Alerts for Network Devices
After enabling KPIs on a device, you can view alerts for that device and get data for each performance indicator
being monitored.
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The KPIs shown in the following steps are examples. There are many more KPIs available in Health Insights.
For the complete list, see List of Health Insights KPIs, on page 64.

Note

Step 1 From themainmenu, choose Performance Alerts >Alert Dashboard. The Health Insights Alert dashboard is displayed.

Step 2 Make sure that the Device Alerts view is displayed (select the Device Alerts toggle, if needed). Then scroll down below
the Alert History panel and click on the All Impacted Devices tab. The dashboard displays a list of devices with alerts.

Step 3 Click on the Device Name for the device whose details you want to view. Health Insights displays the device's basic
Overview information, Alert History, a Topology map, and the list of the device's currently Enabled KPIs.

The Topology map is a version of the map you see when you select Topology from the main menu.

Step 4 Under Enabled KPIs, click on the desired KPI to view the detailed KPI information. A graphical representation of
that KPIs data, along with a list of alert messages and other information, is displayed on the right.

A graphical time-series representation of the selected KPI is displayed for a 24-hour window with hourly slots.

Step 5 Click on the desired time slot to view the corresponding Raw or Summary graphical data. Move the mouse cursor over
any data point in the graph to view additional popup information for that data point.
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A red line or tag represents a point at which the KPI was triggered. This can occur on any subscribed statistic the KPI is
monitoring. Health Insights collects and identifies the time points and frequency, which help determine when these events
become an operational concern.

Graphical data is only visible for time slots that has alerts triggered. To view the alerts for the last 24 hours,
go to the grafana dashboard (https://<IPaddress:port>/robot-grafana/), and select the desired KPI from the
dashboard or from the drop-down list. By default, the KPI display is set for last 1 hour. You can change the
duration (maximum up to last 24 hours) by selecting the desired option from the drop-down.

Note

Telemetry Data Retention
Telemetry data is collected from devices and stored in the time-series database. This data is retained for one
hour, and is used in the Health Insights Alert dashboard to identify alerts using a process known as stream
based alerting. The resulting 'alerts', if any, are stored in the same time-series database. The alerts are retained
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for 30 days, and the messages showing the duration of alerts are displayed in the top right corner of the
Device/KPI view in the Alert dashboard. For more information, see View Alerts for Network Devices, on
page 56. The alerts can also be queried using REST APIs.

The telemetry data displayed in the Alerts dashboard is limited to last only for one hour.Note

Manage KPIs
The Health Insights Key Performance Indicators (KPI) window gives you complete access to Cisco-supplied
and user-created KPIs. You can add, edit, delete, import, and export your KPIs. You can also link your KPIs
to the Change Automation application's Playbooks, which enable scripted responses to KPI changes.

To display the Health Insights Manage KPIs window, choose Performance Alerts > Key Performance
Indicators (KPI) from the main menu.

DescriptionItem

Add KPIs: Click to add a new, user-created KPI. For help with this task, see Create a
New KPI, on page 60.

1

Delete KPIs: Select one or more existing user-created KPIs in the list and then click . You
will be prompted to confirm that you want to delete the KPIs. Click Delete to confirm.

Note that you can delete user-created KPIs only. You cannot delete Cisco-supplied KPIs.

2
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DescriptionItem

Import KPIs: Click to import new user-written or Cisco-supplied KPIs.

Youwill be prompted to browse to the gzipped tar archive containing the KPIs to be imported.
When you have selected the archive, click OK to begin importing it. Once imported, the
new KPIs will appear immediately in the list of KPIs, with each KPI name and category
assigned based on the definition in the KPI itself.

In order for Cisco Crosswork Change Automation and Health Insights to import them, KPI
files must:

• Be packaged as a gzip tar archive. You can include more than one KPI in a single
archive; each will be imported as a separate KPI.

• Have unique names and descriptions. These must not match the name or description
of any Cisco-supplied KPI. If the name or description of the KPI matches an existing
user-created KPI, the import will overwrite the existing KPI.

• Meet other minimum requirements for Health Insights KPIs, as explained in the Cisco
CrossworkNetworkAutomationCustomKPI Tutorial Documentation onCiscoDevNet.

3

Export KPIs: Select one or more existing KPIs in the list and then click to export them.
Health Insights will package the exported KPIs as a single TGZ archive with a unique name.
Your browser will then prompt you to save the archive to a name and location in your local
file system that you select.

4

Link Playbooks: Select a KPI and then click to link it to a Playbook. That Playbook
will execute whenever the KPI raises an alert thereafter. You can specify the values the
Playbook will use when operators trigger it in response to the KPI alert. For help with this
task, see Link KPIs to Playbooks, on page 62.

5

Unlink Playbooks: Select a KPI with a linked Playbook and then click to unlink the
Playbook. You will be prompted to confirm that you want to unlink the Playbook. Click
Unlink to confirm.

6

Clear Filters: Click Clear All Filters to clear any filters you have set.7

Filter KPI Categories: To find a KPI category, enter all or part of the KPI Category name

in this field. Then click to filter the list below.

8

Filter KPIs: To find a KPI, enter all or part of the KPI Name, Category, Description, or
Linked Playbook in the fields provided. The list below is automatically filtered to match
your typed entry.

9

Create a New KPI
You can create a custom KPI and enable it on the desired devices. The workflow is as follows:

1. Supply basic information, such as the KPI name and a summary description.

2. Set the KPI cadence.
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3. Select a YANG module and choose sensor paths

4. Select an alert template and set its parameters

5. Enable the KPI on the devices.

Health Insights supports creating and using KPIs that will use GNMI as the transport and use sensors based
on Open Config (OC) YANGmodules for collecting telemetry data (with GNMI transport). The requirements
for this feature are:

• GRPC need to be configured in your device.

• The device properties, while onboarding, must mention GNMI under theCapability field, and the GNMI
protocol details must be provided under the Connectivity Details field.

• While creating a KPI, choosing an OC YANG module supports the KPI affinity for GNMI transport,
while choosing Cisco-provided YANG models provides the KPI affinity for both MDT and GNMI
transports.

The GNMI transport capability is determined at runtime based on the the following factors such as GNMI
capability of the device, GNMI affinity of the KPI, and the combined capability as a set of devices in a KPI
Profile.

Note

The following steps explain how to create a KPI:

Step 1 From the main menu, choose Performance Alerts > Key Performance Indicators (KPI). The Key Performance
Indicators (KPI) window is displayed.

Step 2 Click the . The Create KPI window opens.
Step 3 In the text fields provided, enter a unique KPI Name, a short KPI Summary description, and KPI details. The KPI

Group is preset to User Created.
Step 4 The Cadence field sets the number of times per minute the KPI will gather sensor data from the devices on which the

KPI is enabled. Leave it at the default or use the numerical selector to choose a different value.
Step 5 In the YANG Modules area, choose one module and one or more sensor paths from which to stream data:

a) Use the Module field to filter and choose the desired Cisco IOS XR YANG module.
b) Use the table fields to filter and choose the desired sensor path. When you choose a path, the leaf node gets resolved

to the base encoding path. If the YANG module is hierarchical, the field names are concatenated down from the base
path. Note that only one gather path is supported for user-created KPIs.

Click Next to display the Select Alert Templates window.

Step 6 Choose the alert template you want to use with your new KPI: No Alert, Standard Deviation, Two-Level Threshold
or Rate Change. Then click Next to display the Alert Parameters window appropriate for the type of alert template
you chose.

Step 7 Edit the alert template parameter values as appropriate for the template and the purpose of your KPI, as follows:

• Use the Basic and Advanced Parameters dropdowns to view and edit the parameter sets you need.
• Change alert parameter numerical values using the selectors or by editing the field contents
• Change alert parameters with discrete choices using parameter field dropdowns and select each choice as needed.

• Learn more about an alert parameter: Hover your mouse cursor over the shown next to the parameter name.
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• Click the View Tick Script link to view the tick script code you are generating with your changes. The tick script
code updates as you make your edits. At any time, click the Hide Tick Script to close the tick script code window.

Step 8 When you are finished making changes, click Finish to save the new KPI and display the Key Performance Indicators
(KPI) window.

Link KPIs to Playbooks
You can link any Health Insights KPI to one Change Automation Playbook of your choice. A user can run
the linked Playbook whenever the linked KPI raises an alert in response to the event associated with the
performance indicator the KPI is monitoring. The KPI alert can be raised in response to a threshold crossing,
topology changes, flapping conditions, and other parameters. These parameters will vary, as appropriate, for
each KPI.

This procedure is not applicable if the Change Automation application is not installed in your device. In this
case, the UI features that link Health Insights and Change Automation (e.g. Link Playbook) are not displayed
in the UI.

Note

You can specify the Source of the parameter values the linked Playbook will use when you run it. You can
select these sources:

• Playbook: Use default values coded into the Playbook itself

• KPI Alert: Use values taken from the alert raised by the linked KPI.

• Runtime Input: Use values you enter only at the moment you run the Playbook.

The ability to set the source of these Playbook parameter values gives you flexibility in how you use the linked
Playbook. For example: Link the KPI Interface flap detection, which detects interface flapping, to the
Playbook Interface state change on XR, which can be used to set the interface up or down. Depending on
circumstances, you might want to set the Playbook parameters as follows:

• Playbook: You want to run the Playbook as it normally does, so you would set the Source as Playbook
for the provider, collection_type and mop_timeout parameters. In the case of the collection_type, you
can still choose between telemetry and snmp, depending on whether you want to useMDT or SNMP
to gather device data.

• KPI Alert: You want the Playbook to run only on the host device and interface affected by the flapping,
which are identified in the flap-detection Alert. So set the Source of the Playbook's hosts and if_names
parameters to KPI Alert. You can then use the alert's data about the Producer device and the
interface_name of the flapping interface on that device.

• Runtime Input: You want the freedom to decide at runtime whether to bring the flapping interface up
or down. So set the Source of the Playbook parameter admin_state to Runtime Input. The Playbook
will prompt you for an up or down choice when you initiate the run.

The following figure shows what this set of choices will look like:
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Figure 10: Example: Specifying Parameter Value Sources for a Linked Playbook

Step 1 From the main menu, choose Performance Alerts > Key Performance Indicators (KPI). The Key Performance
Indicators (KPI) window opens, displaying lists of the KPI categories and the KPIs available in each category.

Step 2 Select the KPI you want to link to a Playbook. You can use filters to find the KPI you want, as explained in Manage
KPIs, on page 59.

Step 3 Click . The Link Playbook to KPI window opens.

Step 4 The left side of the window lists the name of the selected KPI and the Playbooks appropriate for linking to it. Scroll
through the list, or use the Playbook Name field to restrict the list to just the Playbooks you want.

Step 5 When you have found the Playbook you want to link, click on its name. The right side of the window will then list the
Playbook Details for the selected Playbook, including:

• The hardware and software platforms with which it is compatible.

• The minimum software version requirement

• The Source and default values that will be used when the Playbook runs. In many cases, you can select from a range
of default values, or enter your own.

Step 6 Verify or modify the Source and parameter values as needed.
Step 7 When you are finished making changes, click Link to KPI. The Key Performance Indicators (KPI) window is

displayed again, this time with the linked Playbook shown next to name of the KPI in the Key Performance Indicators
(KPIs) list.

Step 8 To change the Playbook linked to a given KPI, repeat steps 3 through 7 for that KPI, this time choosing the Playbook
you want. To unlink a Playbook entirely, select the KPI and click .

Verify the Deployment Status of Enabled KPIs
After you enable a KPI Profile, you can verify the deployment status.
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Step 1 From the main menu, choose Performance Alerts > KPI Job History The KPI Job History window lists the jobs that
have been run most recently, indicating whether they succeeded or failed, when they ran, and on what devices.

Step 2 Click the transaction ID in the job listing to view detailed KPI job information, including the device on which the KPI
Profile was enabled and the KPI ID.

List of Health Insights KPIs
The table below lists the prebuilt Health Insights KPIs supplied with Cisco Crosswork Change Automation
and Health Insights.

Alerting types in the table that you can select when you create a new KPI (see Create a New KPI, on page
60) are:

• No Alert: The KPI gathers, tracks and reports performance data without triggering alerts.

• Standard Deviation: The KPI detects spikes or drops in measured values and alerts when these values
deviate some number of standard deviations away from their normal values.

• Two-Level Threshold: The KPI detects abnormal measured values using two custom thresholds and
the ability to provide dampening intervals on the thresholds.

• Rate Change: The KPI detects abnormal rates of change in measured values to detect rising or falling
values.

Additional alerting types that you can use when you export and use a prebuilt KPIs to create KPIs with custom
parameters are:

• Standard Deviation of Rate Change: The KPI alerts on standard deviations of the rate of change.

• Low Single Threshold: The KPI alerts on a single threshold when the value falls below that threshold.

• Direct Alarm Forwarding: The KPI uses the alarm from the device directly, as a Health Insights KPI
alert.

• Major/Minor/Low/High Thresholds: The KPI alerts onMajor high, Minor high, Minor low, andMajor
low values.

• Line State Changes: The KPI alerts on shutdowns and flapping in line states.

For more on creating KPIs with custom parameters from exported KPIs, see the Cisco Crosswork Network
Automation Custom KPI Tutorial Documentation on Cisco DevNet.

Table 3: Health Insights KPIs

ProtocolAlertingDescriptionKPI NameCategory

MDT,
GNMI

Rate ChangeMonitors CEF drop counters and
baseline. Generates an alert for an
unusual number of drops.

CEF dropsDataplane-Counters
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ProtocolAlertingDescriptionKPI NameCategory

MDT,
GNMI

Two-Level ThresholdMonitors CPU usage across route
policies and line cards on routers.
Generates an alert whenCPU utilization
exceeds the configured threshold

CPU thresholdCPU

MDT,
GNMI

Standard DeviationMonitors CPU usage across route
policies and line cards on routers.
Generates an alert whenCPU utilization
is unusual.

CPU utilizationCPU

MDT,
GNMI

Low Single ThresholdMonitors device uptime.Device uptimeBasics

MDT,
GNMI

Rate ChangeMonitors port transmit and receive error
counters.

Ethernet port error countersLayer 1-Traffic

MDT,
GNMI

No AlertMonitors port transmit and receive
packet size distributions.

Ethernet port packet size
distribution

Layer 1-Traffic

MDT,
GNMI

Standard Deviation of
Rate Change

Monitors port transmit and receive
packet statistics.

Ethernet port packet statisticsLayer 1-Traffic

MDT,
GNMI

Two-Level ThresholdMonitors bandwidth utilization across
all interfaces on a router. Generates an
alert when bandwidth exceeds the
configured threshold.

Interface bandwidth monitorLayer 2-Traffic

MDT,
GNMI

Standard DeviationMonitors interface statistics (such as
incoming and outgoing packets or byte
counters) organized by protocol.

Interface counters by protocolLayer 3-Traffic

MDT,
GNMI

Two-Level ThresholdMonitors interface flaps and alerts when
flap count reaches set threshold.

Interface flap detectionLayer2-Interface

MDT,
GNMI

No AlertMonitors interface transmit and receive
counters. Generates an alert when
unusual traffic rates occur.

Interface packet countersLayer 2-Traffic

MDT,
GNMI

Rate ChangeMonitors interface transmit and receive
error counters. Generates an alert when
unusual error rates occur.

Interface packet error countersLayer 2-Traffic

MDT,
GNMI

No AlertMonitors interface QoS on the egress
direction for queue statistics, queue
depth, and so on.

Interface QoS (egress)QOS

MDT,
GNMI

No AlertMonitors interface QoS on the ingress
direction for queue statistics, queue
depth, and so on.

Interface QoS (ingress)QOS
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ProtocolAlertingDescriptionKPI NameCategory

MDT,
GNMI

Standard DeviationMonitors interface statistics as rate
counters. Generates an alert when
unusual traffic rates occur.

Interface rate countersLayer 2-Traffic

MDT,
GNMI

Standard DeviationMonitors IP SLA UDP echo RTT.
Generates an alert when unusual RTT
values occur.

IP SLA UDP echo RTTIPSLA

MDT,
GNMI

Standard DeviationMonitors IP SLAUDP jitter. Generates
an alert when an abnormal UDP jitter
occurs.

IP SLAUDP jitter monitoringIPSLA

MDT,
GNMI

Standard DeviationMonitors IPv6 RIB for route count and
memory used by BGP. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

IPv6 RIB BGP route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by IS-IS. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIB IS-IS route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors IPv6 RIB for route count and
memory used by IS-IS. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

IPv6 RIB IS-IS route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors IPv6 RIB for route count and
memory used by OSPF. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

IPv6 RIB OSPF route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors ISIS neighbor summaries for
changes in neighbor status. Generates
an alert when an anomaly is detected
(such as neighbors down or flapping).

ISIS neighbor summaryProtocol-ISIS

MDT,
GNMI

Direct Alarm ForwardingMonitors per-port optical alarms
(current and past).

Layer 1 optical alarmsLayer 1-Optics

MDT,
GNMI

Rate ChangeMonitors per-port Layer 1 errors.
Generates an alert when error rates
exceed the configured threshold.

Layer 1 optical errorsLayer 1-Optics

MDT,
GNMI

Rate ChangeMonitors per-port optical FEC errors.
Generates an alert when FEC errors
exceed the configured threshold.

Layer 1 optical FEC errorsLayer 1-Optics
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ProtocolAlertingDescriptionKPI NameCategory

MDT,
GNMI

Major/Minor/Low/High
Thresholds

Monitors per-port optical power.
Generates an alert when power levels
exceed the configured threshold.

Layer 1 optical powerLayer 1-Optics

MDT,
GNMI

Major/Minor/Low/High
Thresholds

Monitors per-port optical temperature.
Generates an alert when temperature
exceeds the configured threshold.

Layer 1 optical temperatureLayer 1-Optics

MDT,
GNMI

Major/Minor/Low/High
Thresholds

Monitors per-port optical voltage.
Generates an alert when voltages
exceed the configured threshold.

Layer 1 optical voltageLayer 1-Optics

MDT,
GNMI

Line State ChangesMonitors interface line states. Generates
an alert when link states change.

Line stateLayer 2-Interface

MDT,
GNMI

Standard DeviationMonitors LLDP neighbors. Generates
an alert when any sudden changes are
detected.

LLDP neighborsLLDP

MDT,
GNMI

Standard DeviationMonitors memory usage across route
processor and line cards on routers.
Generates an alert when memory
utilization is unusual.

Memory utilizationMemory

MDT,
GNMI

Standard DeviationMonitors memory usage across route
processor and line cards on classic XR
devices. Generates an alert when
memory utilization is unusual.

Memory utilization (cXR)Memory

MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by BGP. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIB BGP route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by connected. Generates
an alert when an anomaly is detected
(such as significant increase or decrease
in route counts).

RIB connected route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by IS-IS. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts)

RIB IS-IS route countLayer 3-Routing
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MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by local. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIB local route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by OSPF. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIB OSPF route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIB for route count and
memory used by static. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIB static route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIBv6 for route count and
memory used by connected. Generates
an alert when an anomaly is detected
(such as significant increase or decrease
in route counts).

RIBv6 connected route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIBv6 for route count and
memory used by local. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIBv6 local route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIBv6 for route count and
memory used by static. Generates an
alert when an anomaly is detected (such
as significant increase or decrease in
route counts).

RIBv6 static route countLayer 3-Routing

MDT,
GNMI

Standard DeviationMonitors RIBv6 for route count and
memory used by subscriber. Generates
an alert when an anomaly is detected
(such as significant increase or decrease
in route counts).

RIBv6 subscriber route countLayer 3-Routing

SNMPNo AlertMonitors interface transmit and receive
error counters. Generates an alert when
unusual error rates occur.

SNMP interface packet error
counters

Layer 2-Traffic

SNMPRate ChangeMonitors interface transmit and receive
counters. Generates an alert when
unusual traffic rates occur.

SNMP interface packet
counters

Layer 2-Traffic
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SNMPStandard Deviation Rate
of Change

Monitors interface statistics as rate
counters. Generates an alert when
unusual traffic rates occur.

SNMP interface rate countersLayer 2-Traffic

SNMPTwo-Level ThresholdMonitors input and output data rates for
black hole behavior.

Checks the ratio of output data rate to
input data rate and verifies that the ratio
is within acceptable ranges, otherwise
a black hole is occurring.

SNMP traffic black holeLayer 2-Traffic

MDT,
GNMI

Two-Level ThresholdMonitors input and output data rates for
black hole behavior.

Checks the ratio of output data rate to
input data rate and verifies that the ratio
is within acceptable ranges, otherwise
black hole.

Traffic black holeLayer 2-Traffic

GNMIRate ChangeMonitors interface error counters;
generates an alert when unusual error
rates occur. This KPI uses
openconfig-interfaces YANG model.

Interface packet error counters
(Openconfig)

Layer 2-Traffic

GNMIRate ChangeMonitors interface statistics (such as
rate counters), and generates an alert
when unusual traffic rates occur.

Interface rate counters
(Openconfig)

Layer 2-Traffic

CLITwo-Level ThresholdMonitors filesystem usage on active
route processor and generates an alert
when filesystem utilization exceeds the
configured threshold.

Filesystem UtilizationFile System

Manage KPI Profiles
The Health Insights KPI Profiles window allows you to create, edit, and delete KPI Profiles.

A KPI Profile is a collection of KPIs and their corresponding parameters such as alert frequency, alert type,
cadence, and more. You can group relevant KPIs into a KPI Profile, give it meaningful name based on the
purpose (for example, environmental or health check), and configure parameters that are relevant to monitoring
a specific type of devices (for example, edge routers). Once the KPI profiles are created and validated by the
system, they are ready to be used. You can select the device(s) in Health Insights, select appropriate KPI
Profiles and enable them. This action enables all the KPIs in the selected KPI Profile. Similarly, you can select
the device(s) and choose to disable the KPI Profiles. This removes all KPIs enabled as part of the selected
KPI profile(s) from the devices (for MDT based KPIs) and the collection jobs for the KPIs on the CDG.

To display the Health Insights KPI Profiles window, choose Performance Alerts > KPI Profiles from the
main menu.
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DescriptionItem

Create KPI Profile: Click to create a new, user-created KPI Profile. For help with this
task, see Create a New KPI Profile, on page 70.

1

Edit KPI Profile: Select a user-created KPI Profile in the list and then click to edit it.
For help with this task, see Create a New KPI Profile, on page 70.

2

Delete KPI Profile: Select a user-created KPI Profile in the list and then click to delete
it. You cannot delete a KPI Profile that has been enabled on any device(s).

3

Filter KPI Profile: To find a KPI category, enter all or part of the KPI Profile name in this

field, and the list is automatically filtered based on your input. Click to clear any filters
you have set.

4

KPI On Profile: The KPI(s) added on the selected KPI Profile and the associated parameters
are displayed here. You can edit the KPI parameters, or remove a KPI from the selected
KPI Profile using the appropriate options here.

5

#KPIs on Profile: This is the number of KPIs added on the selected KPI Profile.6

Enabled Devices: This is the number of devices on which the selected KPI Profile is enabled.7

+Alert Group: Click this option to create Alert Group for the selected KPI Profile. For help
with this task, see Create a New KPI Profile, on page 70

8

Create a New KPI Profile
You can create a KPI Profile and enable it on the desired devices. The workflow is as follows:

1. Supply basic information, such as the Profile name and a description.

2. Add KPI(s) and save the profile.

3. Edit KPI parameters and create alert groups.
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4. Enable the KPI Profile on the devices.

The following steps explain how to perform all of these tasks.

Step 1 From the main menu, choose Performance Alerts > KPI Profiles. The KPI Profiles window is displayed.

Step 2 Click the . The Create New Profile window is displayed.
Step 3 In the text fields provided, enter a unique Profile Name, a shortDescription. The Profile Name can contain a maximum

of 32 alphanumeric characters, plus underscores ("_"). No other special characters are allowed.
Step 4 (Optional) You can specify an external destination to send the data collected by KPIs. To create an external data

destination, go to Administration > Data Gateway Global Settings Provide relevant values for the following fields:

• Server Type: Select either KAFKA or GRPC.

• Name: Select the name of the external destination.

• Topic: Enter a topic to provide context for the data being sent. This field is applicable only for KAFKA.

You need to create a new data destination to export the KPI data. The predefined data destinations cannot
be used for this activity. For more information about creating a data destination, see the Cisco Crosswork
Infrastructure 4.0 and Applications Administration Guide.

Note

Step 5 Add KPI to the profile, using the following filter options:
a) All KPIs: By default, this option is selected and the list of all KPIs are displayed in the list. You can select the

required KPI by checking the relevant checkbox.
b) Recommended KPIs: You can select KPIs based on the KPIs recommended for a specific device. Click

Recommended KPIs and the device list is displayed. You can filter the device list by entering relevant values in
the Name field, or by using tags. Select a device from the list and the recommended KPI list is displayed on the
right side. Select the required KPI by checking the relevant checkbox.

Selecting KPIs from the recommended KPI list of a selected device does not automatically enable the
KPI Profile in the selected device. The KPI Profile can be enabled after it is created. For more
information, see Enable KPI Profile on Devices, on page 73

Note

Step 6 Click Save save the new KPI Profile and display the KPI Profiles window.
Step 7 In the KPI Profiles area on the left side, choose the KPI Profile that you created, and the individual KPI details are

displayed on the right side.
Step 8 You can leave the KPI parameters at the default or choose a different value. To edit the KPI parameters, click Edit

Details, and the KPI Details window is displayed. Edit the parameter values as appropriate for the purpose of your
KPI. The common parameters are:

• Alert: This is an on/off toggle switch for alerting. Based on the Alert parameter value, the corresponding alerting
logic is deployed. Alerting can be enabled even after the KPI Profile has been applied to the devices.

Any KPI using the composite alerting logic need to have the alerting flag set to ON.Note

• Cadence (sec): Set the frequency of sensor data. Set the frequency (in seconds) in which the KPI will gather sensor
data from the devices on which the KPI Profile is enabled.

• Alerting Down Sample Rate: Alert frequency rate. It determines how often KPI data will be evaluated for any
alert conditions, and is relative to the Cadence. For example, if Cadence is 60 seconds and you want to do an
alerting evaluation every 300 sec, then specify Alerting Down Sample Rate as "5".
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Step 9 You can also edit the alert logic parameters of the selected KPI. To learn more about a parameter, hover your mouse
cursor over the shown next to the parameter name.

When different thresholds are desired for different types of devices in the network, it is advisable to create
multiple profiles and split the KPIs across them to meet the needs of different device types.

Note

Step 10 When you are finished making changes, click Save to save the new KPI Profile. Health Insights validates your input
parameters and displays the KPI Profiles window.

You can create up to 50 KPI profiles, and an individual KPI Profile can consist up to 50 KPIs. KPI profile
creation can fail if the total number is exceeded, or if Health Insights could not create the required tags in
Inventory manager. This status is reflected in the profile state. Once profile is ready, it can be applied on
devices.

Note

With the KPI Profiles window displayed, you can enable the new KPI Profiles on one or more devices immediately,
following the steps given in Enable KPI Profile on Devices, on page 73.

See Disable KPI Profile on Devices or Device Groups, on page 75 for instructions to disable KPI Profiles.

Step 11 (Optional) You can also create alert groups for a KPI Profile. Alert groups use boolean logic (cascaded OR and AND)
to combine alert outputs from primary KPIs in your KPI profile and create a composite logic query. To create an alert
group, click + Alert Group. The Create Alert Group window is displayed.

Configuring an alert provider enables composite alert forwarding.Note

Step 12 Provide a relevant entry in the Name field. Summary and Details are optional fields.
Step 13 The Alert Group Conditions area on the right side lets you select a logic gate (AND/OR) and add a KPI on which the

logic is applied. Your alert group can be based on the alert criteria of a single KPI, or it can be a combination of mutliple
KPI outputs. Click the desired logic (AND gate is selected by default), and click the + ADD dropdown list to add an
Item or a Group.

Item allows you to add individual KPI items and set the corresponding alert level, and Group allows you to add a
nested alert group.

Step 14 Choose the desired KPI from the Select KPI dropdown, and select the desired level(s) for which the alerts need to be
set for the chosen KPI. The alert levels are CRITICAL, MAJOR, MINOR, WARNING and INFO. Based on the logic
gate and alert criteria you select, the output of the KPIs are evaluated and the alert is generated.
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In the example shown above, the alert is set based on the output of two logic gates. The first logic gate is the output of
an OR operation between the Memory Utilization and Interface Bandwidth monitor KPIs. If the set alert levels are
met for either of the KPIs, the output of the first logic gate is set as true. This output is considered as the input for the
second logic gate, which is an AND operation with the CPU Utilization KPI. If the alert levels of both the KPIs are
met, the output of the second logic gate is set as true.

Step 15 Click Save to save the new alert group and display the KPI Profiles window. Click Edit Details or to edit or delete
an existing alert group respectively.

Enable KPI Profile on Devices
With Health Insights, you can enable and monitor the KPI Profiles in which you are interested. Instead of
sifting through all the data that a given device can supply, you choose to monitor only the information relevant
to the role the device plays in your network. Your equipment and management infrastructure operates as
efficiently as possible, without requiring the collection and storage of data that is unrelated to device roles.
This operational efficiency reduces the amount of time required to set up specific monitoring, leading to faster
problem identification and resolution.

Note that some KPIs trigger alerts based on deviation from an established level of performance. For these
types of KPIs, it is necessary to allow the system some annealing time in order to establish normal performance
levels.

You can only enable KPI Profiles withMDT-based KPIs on a device that has beenmapped to a Cisco Network
Services Orchestrator (Cisco NSO) provider and attached to a Crosswork Data Gateway.

Important

Do not enable KPI Profiles on devices that are not reachable, as it will likely result in a timeout.Note

To enable KPI Profile on devices:

Step 1 From the main menu, choose Performance Alerts > Enable/Disable KPI Profiles. The Devices window is displayed.
Step 2 Select the devices for which you want to enable KPI Profiles. You can click the Device or Device Tags buttons above

the table on the left to toggle between selecting the devices by name or by tagged device group membership. Depending
on your selection, the device list or the device tag list is displayed on the left.

If you choose to select by Device:

• Click in the table on the right. Type a Name or Device Type in the filter fields. As you type, the table displays
only the devices whose name or type match the text you typed.

• Click the check box next to the device(s) you want. You can select multiple devices at the same time.

If you choose to select by Device Tags:

• Type a tag name in the Name field to find a Device Group in the table. As you type, the table displays only the tag
names that match the text you typed.
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• Click the check box next to the group you want. The names of all the devices in that group appear in the devices
table on the right.

Step 3 ClickEnable KPI Profiles to continue. Health Insights detects the selected devices, their types and models, and retrieves
and analyzes their running configurations. TheKPI Profileswindow presents the KPI Profiles available for your selected
devices.

Step 4 Choose the KPI Profiles you want to enable by clicking the check box next to the KPI Profile name, and click Next.

The Verify Details window appears, listing all the KPI Profiles you have chosen to be enabled on the selected devices.

Step 5 (Optional) To get information about the KPIs included in the KPI Profile. Click the KPI Profile in the Selected Profile(s)
table, and the content of the selected KPI Profile is displayed on the right side. Click View More Details to view the
parameters of a specific KPI. A popup window provides the details of the KPI. Click the to close the popup window.

Step 6 To enable the selected KPI Profiles on the selected devices, click Enable. Health Insights schedules the KPI Profile(s)
as a series of job sets.

The Alert flag for the KPI profile (click Edit Details on the relevant KPI) must be turned ON in order to
trigger an alert when the data is collected.

Note

Enabling a KPI results in configuration of the devices (for MDT-based KPIs) and the Crosswork Data
Gateway attached to the device, to receive and forward the reported data. For SNMP-based KPIs, the
Crosswork Data Gateway will be configured to poll and collect the data, and forward it to Health Insights
for processing and evaluation.

Note

Step 7 From the main menu, choose Performance Alerts > KPI Job History to watch the progress of each job set, as shown
below. You should see job sets completing with a status of "Success". If job sets complete with a "Partial" or "Failed"
status, be sure to read the job completion messages, and check that the selected devices are still reachable.
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When the job sets complete successfully, the KPIs are now associated to the devices and the platform begins the process
of enabling the relevant collection procedures for those network elements. In making these changes, you are automating
the configuration of both the platform and the devices themselves to collect only the information required.

Step 8 From the main menu, choose Performance Alerts > Alert Dashboard. The dashboard shows the alert status for the
devices on which you have enabled KPI monitoring.

• SNMP/MDT jobs may takemore time than expected to reach the completed state when there is an increase
in the number of devices, interfaces and KPIs.

• Enabling KPI profile per device takes around 3 to 5 seconds. If the device is not reachable, it will keep
trying until it is timed out. This may result in the job taking more time to reach the completed state.

Note

Disable KPI Profile on Devices or Device Groups
You can use the Enable/Disable KPI Profiles window to disable the KPI Profiles running on device(s) or
device groups.

Step 1 From the main menu, choose Performance Alerts > Enable/Disable KPI Profiles. The Enable/Disable KPI Profiles
window is displayed.

Step 2 To disable KPIs enabled on one or more devices:
a) Click the Device button above the table on the left. The Devices table displays all the devices, with the total number

of KPIs enabled on each device.
b) Click the checkbox next to the devices on which you want to disable KPIs.

If you select one device, you can disable all KPI Profiles for the device or just some of the KPI Profiles. If you select
more than one device, you can only disable all KPIs for them.

c) Click Disable KPI Profiles. You will be prompted to confirm that you want to disable the KPIs running on all the
selected devices. If you selected only one device, click the checkboxes next to the KPI Profiles you want to disable
on that device, or click the checkbox at the top of the column to disable all the KPI Profiles running on that device.
Click Disable to confirm.

Step 3 To disable all KPI Profiles enabled on all the devices within a device group:
a) Click the Device Tags button above the table on the left. The table displays the list of device tags.
b) Click the checkbox next to the device tag(s) on which you want to disable KPI Profiles.

When you select a device tag, the Devices table on the right shows all the devices that are associated with that tag.
All of the devices are preselected.

c) Click Disable KPI Profiles. You will be prompted to confirm that you want to disable all the KPIs running on all
the devices in the group. Click Disable to confirm.
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Troubleshoot Health Insights
The following table describes issues you may encounter when using the Health Insights application, and their
solutions or workarounds.

Table 4: Health Insights Troubleshooting

SolutionIssue

Apply the KPI again. Under normal circumstances,
doing so will initiate a sync operation between the
device and NSO.

Apply a KPI to a device fails with messages indicating
that Cisco Network Services Orchestrator (Cisco
NSO) and the target device are out of sync or
otherwise out of communication. Message text will
vary, but may include "device out of sync", "NC client
timeout", and other text indicating that there are
connectivity or sync issues between NSO and the
device.

1. Confirm that the KPI configuration job completed
without error: Go to Performance Alerts > KPI
Job History

2. Check the Collection/distribution status: Go to
Administration > Collection Jobs.

Health Insights not receiving data.
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